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Question:
What issues have been fixed in Act! updates?

Product:
Product Family: Act!

 

Note: This list only includes issues that have been fixed in service pack releases, hotfixes, and update releases. It does not include fixes that were implemented
in full version major releases of Act!. For information regarding issues that have been fixed in full version major releases of Act!, refer to the following
knowledgebase article:

Issues fixed in Act! full product releases

To download any of these updates please visit the Act! Download Center.

If you are experiencing an issue that is not listed here, there may be a DBFixer released for that issue. For a list of DBFixers, refer to the following
knowledgebase article:

What are Act! DBFixers and where can I find them?

 

Updates for Act! v24

Version 24
Update 2

Issue
Number

Description

AS-365 MTA - When creating an email invitation the .aoi file does not open to create the invitation in Outlook
AS-416 MTA - The Documents tab Save button does not function
AS-418 The Clear activity tick box tool tip says 'Unchecked'
AS-563 404 error when recording Note or History to too many contacts
AS-574 Universal Search crashes application when not logged into a database
AS-628 Umlaut within Details displays incorrectly for Send email invitation
AS-697 Record to History document has added line spacing
AS-706 Link to info on smart tasks in Activities series menu
AS-775 Insight/Welcome token does not refresh if left open
AS-777 Opportunity and KPI Translation Defects
AS-784 Act! becomes unresponsive when loading history tab
AS-806 Groups/Companies - If required field is not entered page refreshes and data is lost
AS-873 Banner in Monthly/Work week show twice
AS-874 API - FIlter activity on external ID returns all data
AS-876 Multi Select of Contacts is ignored by Note creation
AS-877 History list refresh load blank when filters are changed
AS-886 TS - History Tab takes longer than v23 to load the same items
AS-910 TS - Replace field function becomes unusable after multiple uses
AS-912 Web Integration Contact Sync fails to filter contacts by edit date

Version 24
Update 1

Issue
Number

Description

AS-829 LC - CF - word plugin satellite resources are missing from Windows app install
AS-823 Outlook addin - Activity dialog should have 15 min increments
AS-807 Outlook - Addin "Information" and "Active Database Settings" are untranslated
AS-796 Collection of bugs in new Dashboards Part 2
AS-795 Collection of bugs in new Dashboards Part 1
AS-748 KPI Opportunity charts with Custom Dates shows 0.00 on Welcome Page
AS-733 Word/outlook addin; Translations need correction
AS-695 x64 - Help>Help and Help>Whats New Links lead to: The system cannot find the file specified
AS-620 AZERTY keyboards unable to add â‚¬ symbol within Details
AS-457 x64 - Visual Bug - After clicking on the help menu in Web, all other menus have an extended line at the bottom of each menu
AS-301 MTA Parity - LC - DE/FR/CF - Custom tables layout editor is untranslated

Updates for Act! v23

Version 23
Update 6

Issue
Number

Description

AS-878 BACKPORT: API - FIlter activity on external ID returns all data
AS-847 BACKPORT - Outlook Add-in to v23 Update 6
AS-850 BACKPORT v23 Update 6 - Word addin - Templates path should be saved with other connection info
AS-851 BACKPORT v23 Update 6 - New Word Templates should retrieve save path from registry
AS-849 BACKPORT v23 UPDATE 6 - Word Addin - Save current contact/lookup in db user pref during mail merge
AS-847 BACKPORT - Outlook Add-in to v23 Update 6

Version 23
Update 5

Issue
Number

Description

AS-740 Hotfix - v23 Update 5 - Mail merge to Email not completing with Desktop

Version 23
Update 4

Issue
Number

Description

GROW-2733 Active Pending users cause Act! integration to fail
GROW-2732 API: Preferences returns a 500 and unable to update Outlook preferences
GROW-2722 Memory leak in clear activity dialog (dictionary)
GROW-2683 STA: Unable to save Edited/New Word templates
GROW-2670 Multi-Select dropdown lists reset after 2-3 items.
GROW-2641 TS- Outlook Preferences don't save correctly on some databases(Serialized issue)

Version 23
Update 3

Issue
Number

Description

GROW-2646 ClearActivities Dialog – Text Formatting Toolbar Missing
GROW-2647 Thick black border appears on cefsharp controls due to gpu acceleration

Version 23
Update 2

Issue
Number

Description

GROW-2589 Memory leak with Notes/Histories
GROW-2627 FR/DE - Untranslated success message in Word plugin
GROW-2628 Change the in-app Act! Update to use the ProductID + "Inst" key
GROW-2631 AFW - History preview adds extra space in legacy RTF items between

Version 23
Update 1

Issue
Number

Description

GROW-102 Retrieving hundreds of Campaign Results hangs
GROW-1034 Controls: Update Feature Browser to Utilize Chromium
GROW-1173 R&D: Add Table Joining Capability to Insights
GROW-1200 The Details Column does not adhere to Line breaks for emails attached from Outlook, they appear as spaces
GROW-1268 LC - FR/CF/DE - APFW - Global Toolbar Options window is partially untranslated
GROW-1337 APFW - Add/Remove Contact from group, works once per contact.
GROW-1353 APFW - Editing Opportunity Layout causes new "Referred By" field to appear in centre of editor
GROW-1358 APFW - Actual/Estimated close date must be later than start date message incorrectly appears when closing activity.
GROW-1360 Cannot copy into the add product field
GROW-1430 AFW - FR/DE - New user guide leads to English translation in all region versions of Act.
GROW-1432 AFW - DE/FR/US - Help Menu > Service & Support > Contact Information & Act! (Web) Consulting Link Updates
GROW-150 504 ERROR: "Index was outside the bounds of the array" after opening a database converted to v17
GROW-1546 Email history not showing in opportunity detail view's history tab (desktop only)
GROW-1549 Controls: Update APFW cookies for samesite
GROW-1561 Activity/History/Note Detail Composition preferences are ignored.
GROW-1621 Outlook occasionally becomes unresponsive while Act! Outlook Addin is running
GROW-1657 Emails attach when sent to users when the preference is disabled in preferences

GROW-1820
Email setup wizard - If admin "allow email messages to be attached" is false, InvalidArgument=Value of '-1' is not valid for 'index'.Parameter
name: index

GROW-1846 no lists available
GROW-1917 Alpha - Word Add-in - Mail Merge to email missing data during merge process
GROW-2008 Outlook Add-in - Updating an activity details in Outlook and sending update generates a new activity in Act.
GROW-2092 MTA - Update Tools > Preferences > General verbiage
GROW-2123 SSO - LC - FR/DE - Web Help > help topics need localised
GROW-2140 Web - Application crashes when deleting more than one Group in Web without refreshing page
GROW-2162 APFW - Act Integration still downloads after clicking cancel on password box in Chrome.
GROW-2169 APFW - Browse user can edit and delete reports.
GROW-2173 APFW/MTA - No scroll bars when viewing Note/History if Note/History editing is disabled.
GROW-2175 APFW/MTA - Private activities can be viewed by other Users.
GROW-2180 APFW/STA - Phone Country Code for secondary contacts always defaults to Afghanistan.
GROW-2187 Windows-Contact view-Edit menu-Replace field-Clicking on the ellipsis button in the value field does nothing in the Replace data dialog
GROW-220 TS - Out of memory issue on Social Updates Tab.
GROW-2212 FR/DE Unable to Grant Users Calendar Access

GROW-2220
TS - When creating a remote database from MTA or STA the SYNC_SERVER_MACHINE_NAME in TBL_SYNCDB is that of the machine it was
created from.

GROW-2231 APFW - State in Insight Custom chart field list in UK environment.
GROW-2234 APFW - Takes 2 clicks of header to sort by column in Contact List view.
GROW-2236 APFW - A Contact cannot be deselected from the Contact dropdown when creating a new Activity
GROW-2252 Windows/AFW - Remove Identified AEM Navigation Routes
GROW-2253 Welcome page - Open opportunities data incomplete and assigned to wrong user
GROW-2254 Rebrand: Apply rebrand changes to STA/Windows
GROW-2255 Word: Update add-in to utilize new API and be compatible with 64bit
GROW-2256 Welcome: Update welcome links
GROW-2257 Controls: Update Feature Browser to Utilize Chromium (Google)
GROW-2258 WordCrush Control Not Resizeable
GROW-2266 Web - Tools > Sort causes log out after Advanced Query lookup
GROW-2268 Installer does not detect existing ACT7 instance of SQL 2019
GROW-2269 Update CEF Sharp control to latest version
GROW-2273 Act! Integration.exe displays a prompt regarding the default mail application if installed on a 64 bit Office environment
GROW-2276 R&D: Outlook as a standalone installer
GROW-2277 Update Feature Browser to Utilize Chromium (Social Media)
GROW-2278 Update Feature Browser to Utilize Chromium (Act! Connect)
GROW-2279 Update Feature Browser to Utilize Chromium (Idle Page)
GROW-2280 Insights: Create custom date picker in filter
GROW-2289 The Refresh button does not function in STA 23.0.25
GROW-2290 Remote DB restore does not work for 23.0
GROW-2291 UX - Act Connect - Connection Help steps
GROW-2292 Rebrand: Apply rebrand changes to STA/Windows - Help Files
GROW-2294 Rebranding: Update Splash Screen Re-Branded Images

GROW-2295
FR/DE - User Security role is blank when editing the Admin User who created the database causing error: Object reference is not set to an
instance of an object

GROW-2298 Act! Premium Web Add-ins do not load
GROW-2300 E-Marketing: Remove e-marketing smart task action
GROW-2308 MTA-APFW Parity: Outlook Addin: Email addresses in custom email fields are ignored
GROW-2309 MTA-APFW Parity: Email History: Records as "Call Attempted" if data file is set to personal files
GROW-2321 Google Integration: Number of Days Past to Sync is Blank by Default at Setup
GROW-2322 AFW - Google Integration - The OAuth window does not open
GROW-2326 CLONE FOR RE-TESTING: Opening an email history with an attachment opens the email in an editable state in Outlook.
GROW-2327 Cloud Single Tenant / Web - Activities Tab Columns Sizing/Alignment Issues
GROW-2331 Alpha - ActOutlookUtils runs frequently within Act!
GROW-2332 Word add-in - The Filed List which opens by default when editing a template uses the old UI
GROW-2333 Alpha - Word add-in - Field list opened by using the Field List button can be put behind the main word window
GROW-2335 Alpha - Word Add-in - No Contacts display in the Select Contacts window
GROW-2336 Alpha - Word add-in - Special characters can be displayed when a document has been sent via email
GROW-2338 DE/FR - The link to the knowledgebase on the Welcome page leads to a 404
GROW-2339 Alpha - Word add-in - On Select Contacts window cannot add multiple contacts
GROW-2340 Alpha - Word Add-in using "Save as" with an edited Mail Merge template, saves the file as .docx by default
GROW-2341 Alpha - Word Add-in - The Word application is slow to close when the Word add-in is enabled
GROW-2342 Alpha - Word Add-in - The icons appear greyed out but are actually enabled
GROW-2343 Alpha - DE/FR - New (64 bit)Word Add-in is not translated
GROW-2344 Alpha - Word Add-in - Mail Merge Add-in missing the "Add" Button
GROW-2345 Alpha - Word Add-in Feature Parity - Word and Outlook addin Ribbon should be the same
GROW-2346 Alpha - AFW - After setting "Emarketing" as the Startup screen, no longer able to get into the Database via Web
GROW-2351 Alpha - Opportunity history displays incorrect data
GROW-2353 Rebranding: Update EULA
GROW-2355 On Act! Connect, download link to browser from Act! opens a blank page and no download.
GROW-2356 Alpha - Word Add-in - Regarding is ignored when history is saved
GROW-2357 Alpha - Email Record - Sent, Received and Quick attached EMails, are not Recording to History
GROW-2358 Alpha - Opportunity - Product List icon in Web is not present
GROW-2361 Alpha - Connect Link - Download link leads to blank page and no download
GROW-2363 Add beta bomb
GROW-2364 Alpha - word plugin - template fields do not contain merge column information
GROW-2365 Alpha - Word add-in - Add-in does not function correctly if the Act! address book is not configured
GROW-2366 Alpha - Outlook Add-in - Create activity button does nothing
GROW-2367 Alpha - FR - Outlook Address book Search button "Rechercher" is truncated
GROW-2368 [v23.0] NPS CustomerSure: Update In-Product Links
GROW-2370 Alpha - FR/DE - The default date format in Act! is incorrect
GROW-2371 Alpha - FR - “Group Address” and “Group Access” tabs are untranslated
GROW-2372 Alpha - DE/FR - The Month labels on Act! Insight Charts are partially untranslated
GROW-2373 Alpha - FR/DE - AFW - Calendar Preferences partially untranslated
GROW-2374 BETA - LC - DE/FR/CF - Missing string in the Installation wizard within the Custom Install window
GROW-2375 Alpha - FR/DE - Changing record creation from Public to Limited causes log-out
GROW-2376 Alpha - DE - The options for Public, Private and Limited record creation options are untranslated
GROW-2377 Alpha - Setup assistant leads to 404 error page
GROW-2381 Alpha - The Act! API installer UAC prompt references "Swiftpage"
GROW-2383 Alpha - Act! Emarketing remains as an option on the NavBar when upgrading to 23.0
GROW-2386 Alpha - Word Add-in - Cancelling the "Attach to Contacts" window attaches the document to the selected Contact
GROW-2387 Alpha - Word add-in - When a merged Word document is saved and attached to a contact the name always displays as file.docx
GROW-2393 STA - FR/DE - New user guide leads to English translation in all region versions of Act.
GROW-2400 Alpha - Social Updates tab requires user to log back into LinkedIn/Facebook whenever Act! has been restarted
GROW-2402 ALPHA: DE/FR - Create DB and Open DB are untranslated when launched from idle page when installed on English OS
GROW-2403 FR/DE - Connect link window opens browser instead of in Act!
GROW-2405 Alpha - Word Add-In: Alert User to Issue when API not connected
GROW-2406 Alpha - Connect Link > Download Link > API Download
GROW-2407 STA - Mail Merge - RegKeys not creating correctly at install
GROW-2408 ALPHA: Creating a template via Write > New Letter/Email Template... from the Write menu defaults to Word Document and not ADT
GROW-241 APFW-IE11 The Ctrl+ A keyboard shortcut doesn't work in Act! Word Processor
GROW-2425 AFW - 64 bit Office - Sync causes prompts to appear regarding no default mail client when synching between Act! and Outlook
GROW-2426 Alpha - STA - Act Installer - When closing the Act installer, there is reference to Swiftpage 2017
GROW-2429 AFW - Private Activities created using the Outlook add-in appear as public in Act!
GROW-2432 Alpha - Word Add-in - When selecting a My Record merge field, previously it displayed MY on the merge field name in the document
GROW-2435 Outlook/Word Add-in - When switching from Contacts to Groups and back to Contacts the contact list is blank
GROW-2436 Prereq runs SQL scripts to update Demo DB ad infinitum
GROW-2437 Install - Cannot upgrade without stopping IIS in some scenarios
GROW-2438 Updated Links (1/15/21) - AFW/STA - DE/FR/US - Help Menu > Service & Support > Contact Information & Act! (Web) Consulting Link Updates
GROW-2441 ALPHA PHASE 2 - Outlook Add-In: Outbound emails do not record as history for any type
GROW-2442 Alpha - Word Add-In: User is not alerted when an email is not sent to a contact without an email on file

GROW-2443
ALPHA PHASE 2 - Recording history after editing a document template and merging from the Act! add-in saves the file to the database as a .adt
instead of .docx

GROW-2444 ALPHA PHASE 2 - Missing borders on Word/Outlook Addin Dialogue boxes.
GROW-2445 ALPHA PHASE 2 - Outlook add-in 'Create Activity' button doesn't work
GROW-2446 ALPHA PHASE 2 - Add tooltip for 'attach to act' in word add-in
GROW-2447 ALPHA PHASE 2 - Creating Activity from Outlook add-in does not show location in Act!
GROW-2448 ALPHA PHASE 2 - After setting up web users must restart Act!
GROW-2449 ALPHA PHASE 2: Poor wording in email popup
GROW-2453 ALPHA PHASE 2: Google Integration Email Recording Issues
GROW-2454 ALPHA PHASE 2: Web Installer: Remove old Word Add-In
GROW-2455 ALPHA PHASE 2: Word Add-In: "Print & Record" dialog needs to always pop-up on top of all other windows
GROW-2456 ALPHA PHASE 2: Standard users can create remote databases
GROW-2457 Windows/STA - Emails attach when sent to users when the preference is disabled in preferences
GROW-2458 CLONE - APFW/MTA - Email Merge does not send attachments or record the attachment to history.
GROW-2459 ALPHA PHASE 2: Testing Account settings error does not stop functionality
GROW-246 Browser-chrome: Companies - The navigation bar needs to be adjusted
GROW-2460 FR/DE NDBMSSQL files in v23 have missing metadata
GROW-2461 ALPHA PHASE 2: APFW - Global Toolbar Options window won't appear
GROW-2462 ALPHA PHASE 2: Open Opportunities on the Welcome Page do no display in correct order
GROW-2463 ALPHA PHASE 2: Email Mail Merge template with an image does nothing
GROW-2464 ALPHA PHASE 2: New Templates don't save as .ADT
GROW-2465 ALPHA PHASE 2: Outlook Add-In UI - Wrong or missing German translations
GROW-2466 ALPHA PHASE 2: Insight chart 'Revenue vs Costs' not displaying data for this week
GROW-2469 ALPHA PHASE 2: Word Add-In: Implement Pop-Up Warning when documented not saved and merge is attempted
GROW-2470 ALPHA PHASE 2: Opportunities List View DE Translation Missing
GROW-2472 ALPHA PHASE 2: Welcome Page: DE "Knowledgebase" incorrectly translated
GROW-2473 ALPHA PHASE 2: Unable to Mail Merge to Email
GROW-2475 ALPHA PHASE 2: STA - Edit Mail merge template - Merge from within Edit state does not process merge
GROW-2478 ALPHA PHASE 2: AFW - When saving a template on a web client the User is presented with the incorrect window
GROW-2479 ALPHA PHASE 2: AFW/MTA - Sending a mail merge displays an error
GROW-2494 ALPHA PHASE 2: STA - Mail Merge - Email Recording preferences between users are ignored
GROW-2497 R&D: Google Integration - Some Users Unable to Request Oauth Token
GROW-2498 Google Integration: Add New Dialog Pop-up for OAuth Token Request Workaround
GROW-2499 BETA: Word Add-In: Pop "Show Fields" dialog automatically when opening existing .adt file
GROW-2500 Old Word addin still loads for upgrades (some scenarios)
GROW-2501 BETA: Splash screens and Help About should all say Copyright 2021
GROW-2503 BETA: Unable to Scroll in Details Window (RTF Control)
GROW-2508 Beta - Outlook addin - /api/cache-refresh seems to be repeatedly called
GROW-2509 Beta - word addin - Thread culture needs to follow the reg similar to the outlook addin.
GROW-2510 BETA: Letter Sent records as Attachment
GROW-2511 BETA: DE - Cut lines in Outlook integration settings
GROW-2513 BETA: Word Add-In: "Show Fields" missing field options
GROW-2517 BETA: Word Add-In - Address Book - No Double Click Capability
GROW-2518 BETA: Change layout in Act! and Act Crashes
GROW-2520 BETA: Outlook Add-In - Attaching Email does not autofill with the matching Contact
GROW-2524 BETA: Insights - Several Custom Date Picker Issues
GROW-2525 BETA: Advanced Queries Date Field Error
GROW-2527 BETA: Word Add-In - Need to be able to select multiple contacts
GROW-2528 BETA: Word Add-In - "Record to History" or "Print & Record" - Required to Save First
GROW-2529 BETA: Outlook Add-In - Update "Auto Attach" Preferences
GROW-2530 BETA: Word Add-In - Save Document should default to templates folder
GROW-2533 BETA: STA - FR/DE - Object reference is not set to an instance of an Object when trying to open a Database.
GROW-2536 BETA: Outlook Integration: Legacy (Generation 2) Add-In still present
GROW-2539 Error on login if startup view is not welcome page
GROW-2542 BETA: Word Add-In - Add Select All and Remove All options for adding / removing Contacts
GROW-2544 Welcome page/any first CEFBrowser control throws error
GROW-2583 Update v23.0 EULA's by Region
GROW-2584 Word Add-In: Missing v23.0 Translation Strings (Ribbon Labels, Tool Tips & Group selection)
GROW-2586 AFW - Word integration save dialog pops behind show-fields dialog
GROW-259 BETA - LC - FR/CF/DE - User Roles list is untranslated within Manage Users
GROW-2590 ALPHA: Update Welcome Page Links

GROW-268
ISPA: BETA LC DE/CF/FR - Activities synced to Outlook contain untranslated Activity Type when viewing the details of the activity in Outlook
Calendar

GROW-292 TS - APFW - Cannot change Opportunity pipeline colours in IE11.
GROW-297 TS - APFW: Picture fields do not merge from APFW.
GROW-399 APFW - Country codes don't sync to Outlook.
GROW-426 Switching databases if custom field is selected as quick lookup entity , breaks quick lookup in second database
GROW-472 LC - FR - Changing region prevents user from selecting start/end date
GROW-475 Inbound emails do not record if Outlook is closed when using an Exchange Server.

GROW-479
TS - FR/DE - "Invalid processor state. Processor not currently in a transaction." when creating smart tasks triggered when emarketing conditions
are met

GROW-481 LC - FR/CF/DE Templates within Industry Template Library are not translated
GROW-528 Windows: Mail Merge-Images in Picture fields, do not merge to word or outlook, when used in a template
GROW-531 Windows - Detail view/list view hard to see
GROW-534 Social Update, does not properly refresh after navigating through contacts
GROW-544 APFW - Mail Merge - ADT file images not displayed in Outlook
GROW-561 APFW - Some contents do not display completely after ran "History Summary Classic" Reports.
GROW-619 Word Add-In: The email message body in Outlook is inconsistent with Word when send email from Word Add In.
GROW-633 RDB syncs in only one direction and no errors shown in logs.
GROW-673 Browser IE11: For all the menus, upon mouse hover on tabs the blue lines are missing at the end
GROW-680 Field name in navbar lookup panel is highlighted on opening Act!
GROW-782 AEM: Hide AEM from tools menu
GROW-867 TS - Remove Plaxo from demo DB and blank DB web info tab
GROW-908 AEM: Remove 'Get Leads' from tools menu
GROW-913 Cannot open a copy of a database when using SQL 2019
AMA-597 Act API Version
AMA-593 Landing page date field, fails to add contact.
AMA-591 Clicking the image preview of a template always takes the User to TemplateEdit.aspx
AMA-590 SMS replies do not go in to the most recent Campaign
AMA-589 Release Hold and Release Old Issue
AMA-588 Email Dashboard Update
AMA-587 Sparkpost - Send Email
AMA-586 Sort filters for date ascending and descending chronologically are inconsistent
AMA-585 SMS Connector
AMA-584 SMS - IBG - Get Number Issue
AMA-583 Push SMS Sends and Replies to Act History record.
AMA-581 Remove DKIM for IBG
AMA-580 Add hamburger icon for dragging items into folder in grid view
AMA-579 R&D: Pre-headers not being populated in email templates
AMA-578 Segmentation Cleanup
AMA-575 Sparkpost Send Attachments
AMA-574 Lead View V2
AMA-573 ListSelectV2.aspx Bug
AMA-572 Template Editor - Import/Export
AMA-571 Segmentation Refactor
AMA-570 Landing page removes slashes when single textbox is linked to website field
AMA-569 CRM Log Disclaimer
AMA-568 Drip Dashboard Updates
AMA-567 SQL Template Bug
AMA-565 Grid View Folders
AMA-564 Email Domains - Reply to Address
AMA-563 UI Fixes on Email Domains Page
AMA-562 AMA emails do not trigger Auto-replies.
AMA-561 Folders for Assets
AMA-560 Folders and Items
AMA-559 Preference Center - Adjustments
AMA-557 Folders - Final
AMA-556 V2 Select
AMA-555 Landing page social sharing tool does not pull images from image library
AMA-554 Folders in Use
AMA-553 Layout Designer
AMA-552 Pages - Impressions
AMA-551 Folders
AMA-548 DE - Test Email window confirmation button is truncated (SendCastSendTest.aspx)
AMA-547 DE/FR - Email Properties window confirmation button is truncated (TemplatePropertiesSendCast.aspx)
AMA-546 Portal Layout
AMA-545 Landing Pages to Campaigns
AMA-544 Export Landing Page - Move to job
AMA-543 IBG email alert shows Act! instead of Infor in the message
AMA-541 Custom Fields Items
AMA-539 Forms - HTML Display Type
AMA-538 UI Adjustment - Page Results
AMA-537 Page and Campaign Designer
AMA-536 Custom Fields V2
AMA-534 Drag and Drop
AMA-532 Teams
AMA-531 New campaign in Grid view uses previous
AMA-530 Release Hold Issue
AMA-528 V2 Select
AMA-527 End Actions
AMA-526 Pop-up does not match new UI
AMA-525 Contact View
AMA-524 Preference Management
AMA-522 The Find Member Feature only allows users to search by email address

AMA-520
AMA - When you preform A search from list view in campaign from a different language the 2nd search you do the Filters drop down shows in
English

AMA-519 Tie AMA & Sparkpost suppression Lists together
AMA-518 Revert Link Tracking from SparkPost back to AMA
AMA-516 Acceptance Testing: Manage Preferences
AMA-515 Acceptance Testing: Unsubscribe
AMA-514 List name shows as required if you navigate to the landing page properties
AMA-512 UI Consistencyx
AMA-511 Wizard Changes
AMA-510 AMA- Actions Create Activity does not assign activity to Record Manager of Contact or Act User selected Inside Act!
AMA-509 General Feedback
AMA-508 Assets - UI Consistency
AMA-507 Suppression List - Upload Enhancements
AMA-506 List simulation reports and job completions no longer going through Compliance inbox for IBG
AMA-505 Properties
AMA-504 Pages Changes
AMA-503 New Preference Item
AMA-502 Preference Select
AMA-501 Manage Preferences
AMA-500 Form Items - Order

Service Packs for Act! v22

Version 22
Service Pack 1

Issue
Number

Description

GROW-7 UI/UX: Contact List View Data Binding
GROW-8 UI/UX: Transition to AmCharts4
GROW-10 UI/UX: R & D -- Update Detail View Form
GROW-15 Starfish: Start Starfish Demo Import Job in Asyncronous Mode to Return a Response When Complete
GROW-17 WalkMe: Begin Passing Region to WalkMe via Variable
GROW-21 UI/UX: Translate Custom Charts to AmCharts4
GROW-22 UI/UX: Insights View General Styling Updates
GROW-23 UI/UX: Insights Filter View Styling and Modals
GROW-24 UI/UX: Restyle Infogistics Control for All Other List Views
GROW-25 UI/UX: Adjust Pipeline Chart via AmCharts4
GROW-26 UI/UX: Restyle Opportunity Pipeline KanBan
GROW-27 UI/UX: Restyle Pipeline Filter View
GROW-28 UI/UX: Consolidate Opportunity KPI's to one Box
GROW-31 Outlook Integration: Create Contact
GROW-32 Outlook Integration: Create Activity
GROW-33 Outlook Integration: Attach to Contact
GROW-34 Outlook Integration: Record History (Sent Emails)
GROW-35 Outlook Integration: Record History (Received Emails)
GROW-36 Outlook Integration: Quick Attach
GROW-39 Outlook Integration: Start Sync
GROW-41 Mail Merge: Re-write to Read, Write, Record History using web API
GROW-42 Outlook integration: Installation, Build, & Deployment
GROW-783 R&D: Update Act! Insights to new UI
GROW-786 Update welcome icon in left nav bar
GROW-788 MyAct! - Update existing user management controls in-product
GROW-921 Outlook Integration: Address Book Syncronization
GROW-922 Outlook integration: Update Act!.Integration.Exe
GROW-925 MTA: Build, Installation, Deploy
GROW-1035 UI/UX: Create Separate 'Welcome' Screen for Trial Users
GROW-1066 Outlook: UI/UX Styling Updates - Quick Attach, Attach Contact, History Options
GROW-1089 MTA: Accept the client to support uploading DB via MyAct!
GROW-1103 LC: Handle Translations More Efficienctly
GROW-1139 Add Marketing Automation Tab For Desktop
GROW-1364 Add setting in the installer config file to suppress restart checks
GROW-1366 Update welcome icon in left nav bar - x64
GROW-1386 Remove tools > spellcheck from the menu in chrome for v22.1
GROW-1585 Extended License-free Licprovider assembly needed for Morgan Stanley for 20.0
GROW-87 Insights - Custom charts based on multi-select fields display incorrect data on drill down.
GROW-91 Chrome- After press tab key once, the focus can't move to "Show more options" button.
GROW-92 Unable to Import from Outlook.
GROW-100 APFW - Preferences - Calendar - Cancel Changes - the Cancel button is no responding or responding incorrectly
GROW-105 LC - FR - Incorrect translation in the Activity frequency section
GROW-108 Relationships - type drop down box gets truncated
GROW-111 APFW - Active Contact record in Detail View can unintentionally be added to Activities/Notes/Histories when using a Lookup
GROW-112 APFW - Incorrect label for Users section when filtering views in Opportunities
GROW-116 TS - APFW/APC - Activity colours not showing in task list after making a change
GROW-122 APFW - Custom fields cause the Field dropdown list in Customise KPIs preferences to outgrow the window size
GROW-143 Chrome-There is some truncation issue in 'sales analysis by record manager' report.
GROW-155 Can't select Web API Access permission after adding
GROW-167 APFW - Can't run the target report directly when run report with # in its name.
GROW-171 Chrome- The "Show more options" and "Hide Options" menus are misaligned.
GROW-174 APFW - Misaligned Excel export button on Task List page
GROW-184 TS - "Object Reference not set to an Instance of an object" when pasting tables into an activities details.
GROW-205 Confirmation after creating and immediately deleting a contact
GROW-208 APFW - The first line font size changed for contact relationships detail page after changing text font size and color
GROW-215 The warning has popped up twice when input an existing drop-down list name
GROW-225 APFW - Schedule-> Reschedule Selected menu is grey when the activities tab list has one activity.
GROW-227 Chrome- If the records found exceeds search limit, the "Act!" dialog pops up constantly.
GROW-229 APFW- Error message "Not yet implemented on this page" displays when using Tools -> Spelling feature.
GROW-233 Mac-Chrome- There is a truncation error occurred on reports list page.
GROW-243 APFW "Failed to mark the favourite change event" warning pop up when we make some changes for report description
GROW-244 Chrome "Moving buttons" are all greyed out after moving all columns
GROW-247 Yes/No field on contact list view breaks Annual Event lookup.
GROW-250 LC - DE/FR/CF - Untranslated strings in the KPI settings window
GROW-255 Chrome - Schedule activity from Welcome page causes full screen refresh.

GROW-257
On the warning page which said "Are you sure you want to leave this company?"" The company layout can't be changed after clicking "No"
button.

GROW-261 APFW- There is no response when click on Tools->Sort.
GROW-266 APFW - The drop-down menu of Resources isn't fully displayed.
GROW-267 Automatically check for product updates checkbox won't save
GROW-277 TS - � and ? characters in Regarding field of histories display different in list view and preview pane.
GROW-291 TS - Calculations on a quote adding up incorrectly.
GROW-293 LC - CF/FR/DE - APFW - Messy code occurs on Activity Dashboard Filter dialog.
GROW-301 BETA - Can't "click-off" drop down menus on the Welcome Page/Insights page
GROW-303 APFW - LC - DE/FR - Work Week Preferences not fully translated.
GROW-308 TS - APFW - Difference between updating salutation composition in Chrome and IE11
GROW-316 TS - APFW - Quick Lookup Text doesn't change when selecting a date field.
GROW-320 Attach File icon on History tab, attaches file to documents tab.
GROW-337 TS - Object reference error when trying to customise columns in dashboards edit mode.
GROW-340 LC - DE Setup wizard contains truncation in page 3/6 of new DB screen
GROW-342 APFW - Altering items in the Nav bar then clicking Search gives a display error
GROW-343 Outlook - Create contact input boxes not in order
GROW-351 APFW - Calculated field shows incorrect number of decimal places in web.
GROW-364 TS - Inbound emails do not record as Subject, Message and Attachments.
GROW-377 LC - DE - Truncation in Activity Invitations Dialog.
GROW-383 TS - APFW - Apostrophe in Opportunity Process name causes most data to not display in detail view
GROW-386 LC-FR/DE/CF Truncation issue occurred on the "Add Permission" dialog.
GROW-388 APFW - Unable to add image to layout editor
GROW-398 LC - DE/FR - Campaign Results Tab not fully translated.
GROW-404 TS - APFW - Company Field Names with Trailing Spaces Won't Display in List View
GROW-405 TS - APFW - Select Layout option missing when web page is zoomed.
GROW-416 Tools > Online Manuals > Web Administrator's Guide displays an error
GROW-417 APFW - LC - DE/FR/CF - Web Help files are not deployed correctly
GROW-422 APFW - Chrome/OSX - 'Edit Access' window is truncated
GROW-440 TS - APFW - OK button missing from Insert Date option in Act! Word Processor.
GROW-442 TS - APFW - Tab background black while loading
GROW-443 TS - APFW Word addin not appearing when merging document to Word.
GROW-450 LC-FR-APFW: Some contents aren't translated to French on Dashboard Top 10 Opportunities section
GROW-454 LC - DE - Currency field format incorrect when exported to excel
GROW-456 LC - DE/CF - Get Leads button is displayed in English within the Web Forms tab in Groups
GROW-465 LC-FR/CF- "Newsletter Sign-Up" text truncation occur in "create webform" page
GROW-466 LC - DE/CF - "Create Webform" button is displayed in English in DE build
GROW-469 DE - Version information in About Act contains "German (Germany)"
GROW-473 FR - Opportunity KPI heading are truncated
GROW-475 Inbound emails do not record if Outlook is closed when using an Exchange Server.
GROW-478 LC-FR/DE Truncation in Outlook / Google integration Preferences
GROW-482 LC - DE/CF - IIS prompt in English when installing update 2
GROW-483 TS - Unable to change the number of decimal places in the quantity field in products or the default value.
GROW-487 TS - APFW - Opportunity Activities not gaining correct associations via web.
GROW-493 LC-FR/CF APFW- "Move up" and "Move down" button are truncated in the Customize Columns - Webpage Dialog.
GROW-494 Web API Access permission doesn't display properly in Manage Users
GROW-502 LC-CF/DE: The synchronization success message is not localized after remote db synchronization complete
GROW-506 APFW - Chrome - Define Fields - Spinners hide value field, when creating/editing Currency/Decimal field types
GROW-513 APFW - Creating an Activity in Outlook causes all Users to be logged out the database
GROW-515 APFW - When creating an email invitation the .aoi file does not open to create the invitation in Outlook
GROW-516 APFW: Truncation issue occurred in the "Page Setup - Webpage" Dialog.
GROW-525 APFW - Define Fields - Web user is able to access Define Fields once database lock timer has been started
GROW-527 APFW - Outlook Addin still has Premium Web Branding.
GROW-535 APFW - Cannot re-add 'Regarding & Details' to History tab or History List once removed.
GROW-537 Details icon shows, even with no details entered.
GROW-540 APFW - Remote Sync - 'Finish' button at end of wizard has no effect
GROW-551 AU - The EULA paragraphs are incorrectly numbered
GROW-555 APFW - Opportunities 'Filter By' Panel UI issues.

GROW-566
APFW- Chrome-Change the default setting and click cancel button in General preference page, The page is auto refreshed and the setting is
reset to default when click "No" on the prompt dialog.

GROW-569 Title: APFW- There is no response when click cancel button after changed some setting in Calendar Preferences page.
GROW-572 APFW- There is no response after click Tools > Customize > Columns in Group List View.
GROW-586 LC - CF/DE/FR - Ampersand symbols display amongst text in the Offline Smart Tasks Configuration window
GROW-588 Unfriendly message received when attempting to remove Opportunity stages that have been used in the past
GROW-614 LC - CF/FR - Manage Smart Tasks window is not fully translated
GROW-623 TS - No history created when adding document and existing histories disappear after upgrade.
GROW-626 Chrome - The attachment can't be uploaded on Clear Activity details page
GROW-631 LC - DE - State field label incorrect on 1366x768 contact layout.
GROW-632 AFW/Act! Cloud - Inappropriate messaging for user with no API permissions
GROW-634 Yes/No fields do not display correctly on spillover tables for all contacts.
GROW-635 APFW - Can't look for contact by first and last name when selecting contacts
GROW-636 SDK - Linking a secondary contact to a contact does not update the contact's Edit Date.
GROW-649 APFW - Groups/Companies - No parity between desktop and web to show Dynamic Membership
GROW-651 APFW - Advanced Query - Cannot query off of 2 entities anymore
GROW-672 APFW-IE11-The Send Activity e-mail to contacts option is grayed out after added new contacts.
GROW-675 Chrome - Calendar- The "Associate With" and "Attachment" information is not shown on their textbox after uploaded the attachment.
GROW-678 Chrome - The Act! website crashed after I dragged the Customize columns
GROW-685 LC - Sync server successfully started not localized
GROW-690 APFW - Opportunities Quote will not populate until you have selected the Products tab
GROW-692 APFW - Opportunities - Mini-calendar pop-up appears truncated
GROW-704 Chrome - Spell Check feature in the Tools menu displays an error in Google Chrome
GROW-706 Can't select new Emarketing Send permission after adding
GROW-709 TS - Decimal Places not showing on quote.
GROW-713 APFW -LC- Unsupported Browser "tell me more" links not localized
GROW-722 Customize Columns is enabled when it should not be functional

GROW-725
APFW - After receiving the warning "The record you are trying to create is a duplicate. Are you sure you want to continue?" you are unable to
switch Group/Company using the list on the left

GROW-731 APFW - Toolbar options, border highlight is not completed when hovering over an option
GROW-732 TS - Starting a field name with - or _ causes duplicate checking to auto select field.
GROW-736 Error message popup when click Attach Web Page icon.
GROW-743 APFW - Dashboards squashed over to left.
GROW-745 LC - TS - Prices in German Quote Template show more than two decimal places.
GROW-749 German - Preferences > Admin > Name Preferences truncation issues.
GROW-754 APFW - Quote prefix value not applied when generating Quote via web
GROW-763 APFW - Opportunities - Tab stops in 'Add Product' incorrectly
GROW-769 APFW - Birthday shows 12:00:00 AM beside the date
GROW-771 APFW - Deleting an Activity from My Schedule At-A-Glance module in the Act! Activities Dashboard displays incorrect prompt
GROW-774 Chrome - Empty picture fields have no border and appear missing in the Contacts Detail View
GROW-780 APFW - Error in Application when User tries to change own password when 'User cannot change password' is enabled.
GROW-781 Define fields - Prevent users from adding spaces to custom field alias names
GROW-809 Chrome- Clear Activity cause a full screen refresh.
GROW-810 APFW - Chrome - Option to Send activity e-mail to contacts is greyed out when creating an Activity in Chrome
GROW-811 Insights - Drill down on custom pie charts displays blank data view.
GROW-812 TS - APFW - Cannot adjust field length of Address fields in web.
GROW-817 APFW - No option for choosing 'Today' in advanced query on date field.
GROW-818 UK Inproduct survey URL directs to a US inproduct link
GROW-821 LC - FR Navbar lookup button does not match UI spec
GROW-823 Outlook - Activities - VSTO add-ins do not prompt/Auto-create Act! activity, when you accept a meeting invitation in Outlook
GROW-824 APFW - Clicking Close after viewing the web service address in preferences opens a new web page.
GROW-826 TS - APFW - Cannot change settings of phone field via define fields in web.
GROW-827 Calendar hover over pops up, show detail encoding information.
GROW-828 TS - Phone field History is not tracked the first time a value is entered on new Contacts.
GROW-829 LC-CF-APFW: Check box is not aligned with the text "Remember username" in APFW login page.
GROW-830 TS - APFW - Add Selected to Group is Greyed Out when "Tagging All" from a lookup.
GROW-831 Mac-Chrome- The page number button has a truncation error in the "Products/Services" Tab.
GROW-834 APC - Chrome - Spelling and Outlook Synchronisation options vanish in Tools > Preferences
GROW-839 LC - DE/CF/FR - Truncation - Text truncated within Outlook Synchronisation Preferences
GROW-843 APC - WalkMe Conflicts with Some Pop-Up Windows
GROW-846 TS - APFW/APC - Activities not showing in calendar in their timeslot if show banner is selected.
GROW-847 TS - APFW - Unable to change address field data types in browser.
GROW-848 TS - APFW - Advanced Queries where value contains '+' don't work.
GROW-850 TS - Events not showing in week and day calendar view in APFW.
GROW-851 APFW - Activity duration default not being used when creating a history.
GROW-852 TS - APFW - Spaces removed from phone number when using Freeform format.
GROW-854 APFW - Default Sort Order on Opportunity/Notes Tab is not Date.
GROW-855 TS - APFW - "Link Company" dialog box does not launch if Company field is set to Uppercase or Initial Caps
GROW-856 TS - APFW - Reset not working in Customise Columns in Chrome.
GROW-861 TS - APFW - 'Delete' option is still available to Standard users without that permission
GROW-862 Nav Bar too wide in desktop client.
GROW-863 TS - APFW - Colours of Task in task list, not retained when moving to another page
GROW-866 DE/FR - The Welcome page graphs and filters are partially untranslated
GROW-868 APFW - Regarding Column in Notes, shows all text, compared to Desktop
GROW-869 Notes/Histories reports show HTML encoding for Notes/Histories created in desktop client.
GROW-870 Chrome - The label of "Up" button is changed on Divisions tab after add a new field on Company Layout.
GROW-871 TS - APFW - Deleting an activity from the task list removes all colours
GROW-872 Chrome-Primary fields cannot be automatically copied from the secondary contact when promote a secondary contact.
GROW-873 APFW-Lookup Contacts- The Company List unable to display company lookup sets correct name.
GROW-874 TS - APFW - Unable to view details or accept an activity on behalf of another user.
GROW-875 LC - DE - Help link for Feature Tours uses US redirect
GROW-878 APFW-The prompt box shows truncation issue after uploaded an invalid file type in Chrome.
GROW-879 APFW - History and Notes tabs need loading indicators
GROW-880 APFW - Web client layout designer - Disabled format controls can still be used
GROW-881 APFW - Decimal places options are greyed out in define fields in Chrome.
GROW-882 TS - APFW - Creating a follow-up activity does not associate with Opportunity automatically
GROW-883 APFW - The console is not aligned in the Opportunities Detail View
GROW-884 APFW - Company, Opportunity tab missing Opportunities.
GROW-886 Cannot open a copy of a database when using SQL 2016/2017
GROW-891 APFW - DE Welcome page options are not translated
GROW-892 Activity Invitations display encoding information.
GROW-896 Print preview blank from Activities Detail tab.
GROW-906 APC - Blanking the Date of a History and clicking OK provides a misleading error and prevents the User saving the History
GROW-911 Regarding & Details shows HTML coding when exported to Excel
GROW-912 Word addin not loading with 2016 x64 Office.
GROW-914 APFW - Internet Explorer - When Viewing a Contact in Detail View the layout does not load
GROW-1031 APFW - Define Fields - Not allowing blank, on Date fields, does not work
GROW-1032 APFW - Contacts - Save button is not available, when adding/editing/removing data from User field tab
GROW-1038 APFW - Lookup does not automatically refresh if the Lookup returns only one result
GROW-1052 APFW - Chrome - Cannot attach document while clearing an activity.
GROW-1054 APFW - Clicking Create Lookup button on Company Opportunities tab creates a lookup of contacts.
GROW-1058 AMA - Campaign Dashboard 'Export data' has no effect
GROW-1064 LC - FR/DE - Cannot create sync set for a Standard user.
GROW-1077 Changing font colour in history details forces the cursor into the regarding field.
GROW-1078 Pasting text into the history 'Details' section changes the font to times new roman 12 point.
GROW-1088 TS - AFW - When creating a new Opportunity and opting to create a new contact the application crashes
GROW-1102 APFW - Contact List View logs user out of web.
GROW-1105 APFW - Copy/Move Contact Data Refresh Issue In Cloud/Web
GROW-1132 APFW - Creating an activity while on calendar view logs you out of APFW.
GROW-1133 Activity Details Tab Does Not Display Information
GROW-1140 DE/FR/CA- File missing when opening database 'de-DE.tdf'
GROW-1141 MTA - apfw - Scan for Duplicates - Notification Window opens within Search criteria window in Chrome
GROW-1194 AFW - Opportunity Lookup - When lookup should give 1 match and switch to Detail view, it gives 1 match but stays in List view
GROW-1197 APFW - HTML tags displayed in details column when Exported to Excel.
GROW-1198 AFW - Create Activity from contact card, does not refresh the page in Chrome
GROW-1205 AFW - Define Fields - Editing "Name" or "Item #" in the "Products" fields allows you to select "Use Drop down list" option
GROW-1212 Mispelling on Activation Screen
GROW-1215 APFW - Outlook Addin - With Exclude my record enabled quick attach gives 'No Contact Found' message when trying to attach to own record.
GROW-1216 APFW - Outlook Addin - Exclude My Record preference for Outbound emails is ignored.
GROW-1217 APFW - Outlook Addin - Create contact if not found will not create multiple contacts on an email.
GROW-1218 APFW - Insights: Error: "Data retrieval for the chart failed: undefined" when filtering a custom chart
GROW-1219 Custom tables - Insights - Not able to create a New chart in Insights using any Custom tables data
GROW-1223 TS - Editing Large Activity Details causes flicker effect.
GROW-1225 APFW - Outlook Addin - If history preference is set to None, a blank history is still recorded.
GROW-1228 AFW - Web Mail Merge - If email address used has Special characters in the password, Mail Merge does not send.
GROW-1231 APC - IIS Prompt incorrectly advises the User to recycle the application pool
GROW-1234 APFW - Mail Merge - Document not attached to history when option selected
GROW-1235 APFW - Mail Merge - Attachment not attached to history when sent with email.
GROW-1240 Framework does not expect correct schema version
GROW-1241 APFW - Menus with scroll bars cause sub menus to lose alignment
GROW-1245 APFW - Google Sync - Error at end of OAuth wizard.
GROW-1246 APFW - Outlook Sync - Sync runs but nothing is synced.

GROW-1247
MTA - AFW - Define fields - Changing the Field type of the Company field to any other option presents message "A field with that name already
exists"

GROW-1248 Web - Integration installer specifies path for Outlook only
GROW-1252 APFW - Google Sync - Preferences not displayed when reopening preference window.
GROW-1253 APFW - Outlook/Google Sync - Advanced calendar preference window blank.
GROW-1255 AMA tab in desktop client does not function correctly.
GROW-1256 Marketing Automation tab in desktop client replicates after viewing other areas of Act!.
GROW-1267 APFW - Google Sync - Record History defaults set incorrectly.
GROW-1272 Upgrade from 22.0 to 22.1 causes Act!.exe not to launch
GROW-1274 API warning message everytime you go to contact detail view.
GROW-1279 Manage users object reference error
GROW-1282 MTA - Outlook - Contacts created from Addin, do not appear in Contact list, when using "attach to Contacts" or "Quick attach to Contacts"
GROW-1287 MTA - Mail Merge to Word and Printer not recording history.
GROW-1288 MTA - APFW - Outlook - Attaching an Email to Large number of Contacts, will list all Contacts names it has attached too
GROW-1289 MTA - APFW - Able to download ActMailMegerInstaller.exe
GROW-1300 APFW - Outlook Addin - No history recorded for Outbound Emails.
GROW-1301 APFW - Google Sync - Gmail History Recording records blank histories.
GROW-1306 Act! Integration - When creating a Contact the Contact name is displayed in lowercase
GROW-1307 APFW/MTA - Email Merge does not send attachments or record the attachment to history.
GROW-1308 LC - FR - Truncations in Preferences (Admin Preferences) area
GROW-1310 AFW - The prompt when downloading Integration does not refer to Word Integration
GROW-1314 MTA - The inproduct help link to change a User password leads to a 404 page when using an Offline Client
GROW-1315 Custom Tables - AFW - Creating a multi select drop-down removes the value if only one item is selected
GROW-1320 MTA - APFW - Outlook - Inbound Emails are recorded twice
GROW-1321 Opening an activity created in v21 or earlier adds an additional carriage return
GROW-1322 22.1 Welcome page logic gets token from publisher
GROW-1334 Act! Integration - The preferences window in Google Preferences has items that are not aligned correctly when 2 way sync is selected
GROW-1335 Windows - Annoying popup when API is not working upon navigation to the contact detail view
GROW-1344 APFW/MTA - Outlook Addin - Full email history is attached if setting up Outlook on new PC.
GROW-1350 Windows: LC - FR - Incorrect translation in the Activity frequency section

GROW-1352
Notes/Histories - Details - When filling in the details area, if you type to fill the box, the bottom line is always below the window limit and non
visible

GROW-1357 Windows - Outlook - Addin authorize requests are not including HMAC
GROW-1359 AFW - Contacts - Groups/Companies tab Dynamic membership window shows "Group" as title in for either Group or Company.
GROW-1365 MTA: Starfish demo import requires lookup before contacts are accessible
GROW-1372 Act! Web 22.1.172.0 does not install Microsoft SQL
GROW-1378 MTA - Outlook - Contacts created from Addin, do not appear in Contact list, when using "attach to Contacts"
GROW-1382 AFW - Chrome - Clicking an Activity button while in Contact Detail View displays a large window
GROW-1383 Outlook - Duplicate history result types of the same name result in error in addin
GROW-1387 APFW - Embedded images in Emails do not appear in history entry.
GROW-1388 API Word addin - Creating or editing templates does not save changes to supplemental files
GROW-1391 Act! installation stops if MTA Outlook Integration has previously been installed
GROW-1392 AFW - Tools > Define Fields does not open on the first click
GROW-1395 During installation the Region selection is ignored and always installs United States
GROW-1406 APFW - Google Sync - All Emails get recorded against My Record.
GROW-1407 APFW - Gmail History causes corruption in Contacts history tab.
GROW-1410 APFW/MTA - Download button from Word Processor Preference Window is unresponsive.
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GROW-1411 Added columns inside the Contact tab of Groups keep resetting after rebooting PC
GROW-1412 APFW/MTA - Error regarding 'Authentication Required' when doing mail merge to email.
GROW-1413 MTA - 'Delete' moves cursor one space to right on phone fields.
GROW-1416 MTA - Outlook integration - Embedded images recorded as broken image.
GROW-1418 MTA - Recording with Email attachment includes subject & Message in details
GROW-1425 Outlook - Addin - Parser does not function correctly when date is "0001-01-01T00:00:00+10:00"
GROW-1426 SQL-less Silent Install - Blank InstallShield titled message boxes appear during recording of response file.
GROW-1427 SQL-less Silent Install - Recorded response file is incomplete
GROW-1428 SQL-less Silent Install - Custom install path field not available while recording a response file.
GROW-1433 APFW/MTA - DE/FR - Google/Outlook Preferences Windows Untranslated.
GROW-1455 Outlook Add-in - Attach to Contacts shows Result in History as 'Auto Attached'
GROW-1456 Outlook Add-in - When using the 'Create Activity' button the body of the email is not copied to the 'Details' tab
GROW-1461 Outlook add-in - The field labels when creating a Contact in the UK build of Act! are for US address formats
GROW-1471 "ActInstallDir\OutlookInt" needs to be moved to "ActInstallDir\APFW\OutlookInt" for MTA localization
GROW-1481 Outlook Addin - DE/FR - Not translated.
GROW-1482 Google/Outlook Sync not retaining preferences in Pro/Premium.
GROW-1483 Outlook Addin - Details tab does not display correctly when creating activity in Outlook with Act! Pro.
GROW-1487 IE - The KPI Preferences window does not populate fields from Act!
GROW-1521 MTA/APFW - ISPAPasswordForm.aspx is untranslate
GROW-1531 Beta - issue with AFW client help files
GROW-1534 RTF/HTML: Notes adding line break
GROW-1543 LC - en-CA region references fr-CA dictionary for spellcheck
GROW-1544 Database picker for Outlook Synchronization preferences is missing
GROW-1550 Outlook - "Attach to Contact" follows settings for "Auto-Attach" instead of "Quick Attach"
GROW-1551 If there are no opportunities within a specific Process/filter, the sales pipeline graph does not update
GROW-1552 Spacing in tabs on detail view causing users to scroll
GROW-1557 TS - APC When selecting add/remove contacts in the companies view logs a user out of the application
GROW-1558 BETA - System out of memory exception in various areas of v22.1
GROW-1565 Regression - Notes/Histories reports show HTML encoding for Notes/Histories created in desktop client.
GROW-1567 Accents and apostrophes are not recorded in history as expected
GROW-1576 FR/DE - No email history recorded desktop and web client.
GROW-1580 22.1 Licensing change (perpetual v22.0 premium) should be backed out
AMA-270 Categorization: Implement categorization UI within campaigns
AMA-271 Categorization: Implement categorization UI within templates
AMA-284 Categorization: Backend Support For Categorization for Campaigns
AMA-285 Categorization: Backend Support For Categorization for Templates
AMA-286 Categorization: Backend Support For Categorization for Landing Pages
AMA-340 WalkMe: Covid-19 Banner
AMA-342 R&D: DNS check for custom domain before allowing a user to change in UI
AMA-350 Update UI on survey Report
AMA-352 Create or edit timezone to show British Summer Time (BST)
AMA-359 Update messaging on pro tier when users copy pre-built campaign with decisions
AMA-363 All pop-ups default (enter) to the positive (confirm) button
AMA-322 Survey Report
AMA-327 Move Captcha Label Above Text Box
AMA-329 Pop-up UI Fixes
AMA-332 Export Transactional Data
AMA-346 Survey Report - Export to PDF
AMA-386 Account Home Subscription Information
AMA-389 Add landing page icon to 'Blank Landing Page' System Template

Updates for Act! v22

Version 22.1
Update 4

Issue
Number

Description

GROW-1610 Add ribbon to email compose window for on the fly attachment preferences
GROW-1717 Prompt new dialog for outlook with API is unreachable
GROW-1724 Re-factor Address Book for Enhanced Performance
GROW-1725 Update Ribbon Features to Utilize New Address Book Architecture
GROW-1726 Match on All E-mail Addresses in the Contact Record (not just primary)
GROW-1765 Ensure IsUser Admin Preference is being read by add-in
GROW-1788 Add address book icon to main ribbon
GROW-1789 Update styling on toast messages in add-in
GROW-1791 Filter out contacts that don't have email addresses in Act! in address book in send window
GROW-1792 Implement an option to add accepted meeting invites from outlook into Act!
GROW-1793 Detect If old address book exists when new add-in is installed
GROW-1794 Improve interaction between the add-in and act.integration.exe
GROW-1851 Make 'add accepted meeting invite' preference available via the API
GROW-1852 Add new pref in add-in for adding accept invites
GROW-1853 Add address book to appointment/meeting window
GROW-1254 APFW - Outlook/Google Sync - After clicking ok to Sync/Integrate now no sync occurs.
GROW-1405 APFW - Google Sync - All Sent emails are recorded twice when doing initial sync.
GROW-1555 APFW - DE - Secondary Contacts window is corrupted.
GROW-1581 Google Sync - No way to change database or password in desktop google sync tab.
GROW-1638 DE - Translation - Outlook integration preferences window
GROW-1640 DE - Office integration - Create Activity Translation
GROW-1645 DE - Office integration - Quick Attach Message Translation
GROW-1772 Cannot edit documents via chrome.
GROW-1797 FR/DE - Emails are not attaching automatically or via Quick Attach
GROW-1818 Outlook - Upper case characters in email address (from Act!) prevent matching
GROW-1829 Outlook add-in - Timeout occurs after approximately 1 hr.
GROW-1830 Outlook Addin - Black boxes appear when saving preferences in Outlook.
GROW-1835 Outlook Addin - Create Contact has black box issue with Toast notifications.
GROW-1836 DE/FR/CF - Outlook Addin - Address Book icon on ribbon untranslated.
GROW-1843 Outlook Addin - Quick Attach toast message doesn't specify contact attached to.
GROW-1844 DE/FR - Outlook Addin - Search button in Address Book is untranslated.
GROW-1847 Outlook Addin - If default preference is set to None, on the fly preferences are not honoured.
GROW-1848 DE/FR - Activity selection window in Outlook activity sync preferences needs Translating
GROW-1850 DE/FR/CF - Outlook Addin - Attach To Contacts Toast Pop up not translated.
GROW-1854 Outlook Addin - The number of pages displayed in the Outlook Address Book is incorrect when using a large database
GROW-1875 Outlook Addin - Quick Attach - Create Contact if Not Found preference does not work.
GROW-1884 Outlook Addin - Quick attach only checks primary email field.
GROW-1890 DE - Outlook Addin - Truncation on button in Attach to Contacts window.
GROW-1893 Outlook Addin - Toast notification logo is truncated.
GROW-1894 FR/DE - Outlook Addin - Create Activity text under the 'Auto Attach' tab is untranslated in desktop and web client
GROW-1896 DE/FR - Outlook Addin - Missing translations in Create Activity window.
GROW-1897 Outlook add-in - The details section when creating an Activity does not contain a scroll barn
GROW-1898 Outlook Addin - No activity created when using the preference "Automatically create activity in default database"
GROW-1900 Outlook - Unable to attach multiple emails to a contact, in one go, when using Quick Attach
GROW-1904 Cannot open dev tools for AMA in cefsharp browser control
GROW-1905 DE - Outlook Addin - Quick Attach button wording is truncated.
GROW-1906 Outlook Addin - Create Contact tab order on address fields is incorrect.
GROW-1908 DE/FR - Google integration preferences - Advanced Preferences Translation.
GROW-1909 DE/FR - Outlook addin preferences - Truncation of text in the Outlook addin preferences.
GROW-1971 Unable to reply to emails in Outlook pop window with Act addin enabled
GROW-1980 Outlook Addin - Create activity automatically does not transfer Subject or Details to Act.
GROW-1988 Outlook Addin - No way to make email history private when using 'Attach To Contacts'
GROW-1989 Outlook Addin - On desktop client the change password window appears behind main Outlook window.
GROW-1996 Outlook add-in - history still recorded when set to none
GROW-1997 Outlook Add-in - Meeting invite time is not consistent between Act! and Outlook
GROW-2002 Outlook Addin - Outlook loses Reply/Reply All buttons after being left for period of time.
GROW-2005 Outlook Addin - Increments less than 30 minutes for meeting durations do not obey the invite duration when set to Edit and Create

Version 22.1
Update 3

Issue
Number

Description

GROW-1629 Cannot write documents via chrome
GROW-1654 Out of memory when opening Act! (sometimes immediate)
GROW-1667 Word-crush error on notes/histories/activities
GROW-1704 Cannot set-up Outlook integration when using a shared database over a network
GROW-1706 Outlook – Add-in address book reconcile async get contact thread limited to 100 seconds
GROW-1710 Outlook Add-in - expired token does not auto refresh
GROW-1744 Update preferences to follow the admin preferences for the user
GROW-1761 DE - Office integration - Quick Attach button Translation

Version 22.1
Update 2

Issue
Number

Description

GROW-1513 Finalize preferences for Outlook/Google Integration
GROW-1605 Outlook: Add verbiage on password dialog
GROW-1609 Move the ReconcileAddressBook to be non-blocking for addin load on non-first startup
GROW-1611 Outlook addin - Get new contacts from Act! API without Outlook restart

GROW-110
BETA - Outlook Add-in - Tab Stops when adding a Contact via Quick Attach (As the Contact does not exist in your database) are not in the
correct order

GROW-176 Opening an email history with an attachment opens the email in an editable state in Outlook.
GROW-219 TS - APFW - Search function in Attach to Act Contacts not working correctly.
GROW-221 TS - APFW - Email Invitation not sent while creating an activity.
GROW-302 Address Books - ACC reports address book removes itself if Outlook is launched before SQL can start
GROW-373 When attaching an email using 'Attach to Act! Contacts' that was sent via Mail Merge the email history settings are ignored.
GROW-475 Inbound emails do not record if Outlook is closed when using an Exchange Server.
GROW-476 LC " FR/CF/DE APFW " All the tool tips in Outlook Add-Ins are not translated to French/German.
GROW-583 LC- Truncation issue occurs on the change database dialog
GROW-660 TS - Opening Act! address book from within new email will cause Outlook to freeze.

GROW-681
Outlook Integration - Associating an activity in Outlook with Act returns message 'this application was created using an unlicensed version of
Infralution Virtual Tree'

GROW-682
Beta - Outlook Integration - Creating Email Invitations from a To-do, Gives error "Unable to display Outlook Meeting dialog due to the error: "The
object does not support this method.""

GROW-718 LC - DE - Missing Translation in Email System Setup Outlook Address Books - Add/Edit dialog
GROW-723 Inconsistency in When Act! Needs to Be Run as Admin
GROW-809 Chrome- Clear Activity cause a full screen refresh.
GROW-826 TS - APFW - Cannot change settings of phone field via define fields in web.
GROW-829 LC-CF-APFW: Check box is not aligned with the text "Remember username" in APFW login page.
GROW-830 TS - APFW - Add Selected to Group is Greyed Out when "Tagging All" from a lookup.
GROW-846 TS - APFW/APC - Activities not showing in calendar in their timeslot if show banner is selected.
GROW-848 TS - APFW - Advanced Queries where value contains '+' don't work.
GROW-850 TS - Events not showing in week and day calendar view in APFW.
GROW-851 APFW - Activity duration default not being used when creating a history.
GROW-852 TS - APFW - Spaces removed from phone number when using Freeform format.
GROW-856 TS - APFW - Reset not working in Customise Columns in Chrome.
GROW-861 TS - APFW - 'Delete' option is still available to Standard users without that permission
GROW-869 Notes/Histories reports show HTML encoding for Notes/Histories created in desktop client.
GROW-870 Chrome - The label of "Up" button is changed on Divisions tab after add a new field on Company Layout.
GROW-871 TS - APFW - Deleting an activity from the task list removes all colours
GROW-872 Chrome-Primary fields cannot be automatically copied from the secondary contact when promote a secondary contact.
GROW-873 APFW-Lookup Contacts- The Company List unable to display company lookup sets correct name.
GROW-874 TS - APFW - Unable to view details or accept an activity on behalf of another user.
GROW-876 Selecting Contact from Act! Address Book in Outlook does not record history.
GROW-879 APFW - History and Notes tabs need loading indicators
GROW-881 APFW - Decimal places options are greyed out in define fields in Chrome.
GROW-882 TS - APFW - Creating a follow-up activity does not associate with Opportunity automatically
GROW-883 APFW - The console is not aligned in the Opportunities Detail View
GROW-1232 APFW - Outlook Addin - Deleting multiple contacts in Act! requires multiple reopens of Outlook to correct Address Book.
GROW-1341 APFW - Print - Print window blank
GROW-1355 APFW - Unable to change email history settings in Outlook Add-In with 64-bit office
GROW-1406 APFW - Google Sync - All Emails get recorded against My Record.

GROW-1439
AFW - Outlook Address book - Integration - After uninstalling the Act Web integration (v22.0 or earlier) some Reg keys are left behind and still
generate an address book

GROW-1489 Google web Integration - Email sync - Emails are only pulled into Act Web by manual sync. Scheduled sync does not pull emails in.
GROW-1517 Outlook Add-in - On first load not all dropdowns have a list of options available when using Act! Desktop Client
GROW-1518 APFW - Outlook Addin - Preferences not saved on 2nd change on initial opening of Outlook.
GROW-1539 Activity text is changed to white after creating an activity
GROW-1540 When entering lots of text in a new History the final line is cut off and scroll bar doesn't display correctly.
GROW-1551 If there are no opportunities within a specific Process/filter, the sales pipeline graph does not update
GROW-1555 APFW - DE - Secondary Contacts window is corrupted.
GROW-1559 Outlook - Addin - Restricted user able to use Addin for some features
GROW-1560 APFW - Deleting an activity causes an aoi file to be downloaded in Chrome.
GROW-1584 Prompted to enter password on opening Outlook even if Outlook integration with desktop is not setup.
GROW-1588 OutlookAddin - Preferences for email recording set via Act do not transfer through to the Outlook Addin.
GROW-1601 FR - Translation - Email integration setup - Step 7/9
GROW-1602 Windows - Pad file picker dialog Object Reference error if "database" key is missing from OutlookAddressBooks
GROW-1603 HTML coding in histories tab when customising columns
GROW-1607 Outlook Addin Truncation - V22.1 various Outlook translation items
GROW-1612 Outlook Add-in - Attach to contacts does not allow sort
GROW-1613 Perpetual - Marketing automation tab should not check for API on perpetual serial numbers
GROW-1614 Perpetual - AMA tab duplicates when navigating between different views
GROW-1615 Outlook Addin - Preferences set in Outlok Addin, are not reflected in Email System Setup Wizard.
GROW-1618 Creating new fields causes alias names to be lowercased
GROW-1619 Outlook - Upper case characters in email address (from Act!) prevent matching
GROW-1620 ACT Integration - Schedule Automatic Synchronization text is squished, appearing to miss spaces between words
GROW-1622 Outlook Integration - .aoi files persist after execution
GROW-1625 ACT Integration - Tab indexes in incorrect order when specifying Act! credentials
GROW-1627 Outlook Addin - Exclude my record option always excludes if contact email is upper case
GROW-1628 Groups/Companies lists should be sorted
GROW-1629 Cannot edit or write documents via chrome.
GROW-1632 APFW/Cloud: Unable to manually attach a document when using a chromium based browser
GROW-1636 Outlook Addin - The 'Exclude My Record' preference for Sent emails only displays correctly after Outlook restart.
GROW-1637 DE/FR - Outlook integration preferences - Truncation of text in the Outlook integration preferences.
GROW-1641 DE - Office integration - Quick Attach button Translation
GROW-1646 APFW/Cloud - Notes displaying with RTF formatting or not displaying at all
GROW-1651 The Synchronise Now button is only active on the first launch of Outlook
GROW-1653 Some users experience preferences not loading in the addin
GROW-1658 Can not add back 'Regarding and Details' once removed from customize columns
GROW-1678 Unable to print calendar view in Cloud

Version 22
Update 4

Issue
Number

Description

GROW-1157 Text defaults to Times New Roman when editing an existing item with the new RTF control
GROW-1154 AFW - Note/History created in Web Client and viewed in desktop does not display text under the Regarding column
GROW-1082 TS - System out of memory exception in various areas of v22
GROW-1056 History List “Regarding” column displays in “Times New Roman” font
GROW-1055 History Tab - Details are cut off or not displayed in "Regarding and Details" field, "Details" field is totally blank
GROW-1053 Font Preferences not respected when creating Activity
GROW-1050 Windows HTML editor - Carriage returns are treated like paragraphs instead of line breaks
GROW-911 Regarding & Details shows HTML coding when exported to Excel
GROW-888 Cannot edit activity details after viewing details and clicking cancel.
GROW-645 APFW Mobile - Act.Web.Controls.Grid.GridHelper' does not contain a definition for RTFtoHTML
GROW-547 Outlook Email History Recording does not insert line breaks when reviewing the message in Act!
GROW-118 Preview Pane displays additional spacing when viewing a Note/History in Desktop that was created in web
GROW-1166 Outlook - Activities - Sending Activity Email invitations, adds HTML code to the email
GROW-1156 AFW - Clearing Activity with notes text appears in the History list formatted in Times new Roman
GROW-1155 AFW - Notes/History created in Act Web do not display correctly in Desktop Client and use the incorrect font
GROW-895 When clearing an activity the 'details' font defaults to Verdana Size 16
GROW-864 Times New Roman font used for 'system changes' history item
GROW-917 FR/DE - Localised dictionaries not identifying correctly spelled words

Version 22
Update 3

Issue
Number

Description

GROW-165 Mac-Chrome: The Add/Remove Contact From Company button truncation
GROW-482 LC - DE/CF - IIS prompt in English when installing update 2
GS-2192 Notes/History reports showing markup
GROW-15 Starfish: Start Starfish Demo Import Job in Asyncronous Mode to Return a Response When Complete
GROW-923 Update 3 Deployment
GROW-322 TS - Activities - Unexpected font-size changes in the Activity editor
GROW-509 History - Contact History: Only 'Details' displayed in 'Regarding & Details'
GROW-820 New Notes and Histories add additional lines of spacing at the bottom of the record
GROW-842 APFW - Cannot schedule Follow Up for activities with details if created in desktop version of Act!
GROW-860 APFW - Attempting to clear activity causes a logout.
GROW-869 Notes/Histories reports show HTML encoding for Notes/Histories created in desktop client.
GROW-888 Cannot edit activity details after viewing details and clicking cancel.
GROW-1030 APFW - IE - Welcome page/Insights don't load.

Version 22
Update 2

Issue
Number

Description

GS-2227 Drill down on the Pipeline chart returns Bad Request when using Web API
GS-2225 APFW - Welcome page does not display after logging out and back in until after a page refresh.
GS-2211 Network sync won't work for AMA tokens
GS-2207 APFW - Manager user and below unable to record emails.
GS-2195 Cloud - Cannot add documents to Contact using Chrome and then get logged off.
GS-2191 RTF with two spaces gets converted to 'Â' instead of '&nbsp'
GS-2190 Small font on rtf editing (8pt)
GS-2188 Printing dialogue is showing a blank page when rendering
GS-2186 Notes/Histories reports show HTML encoding for Notes/Histories created in desktop client.
GS-2184 Right click for RTF editor displays no menu - Keyboard shortcuts allow copy and paste
GS-2180 The My Open Opportunities section on the Welcome Page shows Opportunities for All Users
GS-2169 Change add/remove in elipse for left nav to modal
GS-2155 Welcome Page - Task List Chart doesn't refresh when changing from Upcoming to Past.
GS-2154 APFW - IE - Welcome Page - Task List chart gives errors if data present.
GS-2153 Welcome Page - Task List Chart displays wrong dates.
GS-2152 Truncation in Act! navigation bar when in Marketing Automation
GS-2144 Keyboard shortcut allows System Manager to add Note to Contact
GS-2143 APFW - The AMA data in the Campaign Results tab is not correctly aligned to column headers
GS-2138 APFW - Changes to Nav Bar using Add/Remove items are lost when clicking on other Nav Bar items.
GS-2136 ActWebHookMessengerService is not registered for 22.0 installs
GS-2125 Welcome Page - Locales - Welcome Links appear in English and go to English links
GS-2113 APFW - DE/FR/CF - Toolbar items missing in Opportunity Detail View.
GS-2106 WalkMe - Trial attribute & AcctID
GS-2095 Welcome page contains untranslated elements
GS-1936 JWT errors - prevent AMA conflict with Network Sync over Internet
GS-1877 APFW - A new blank company record is opened when using 'Create Company from Contact'
GS-1835 ISPA - Google - Two way sync causes the email address to be deleted for Contacts with blank email "Label" in Google Contacts
GS-1824 APFW - Layout Designer - Unable to delete items after opening the Properties Window
GS-553 LC - DE/CF/FR - Manage Subscription button leads to non-localized web page
GS-536 LC - DE - Help link for Feature Tours uses US redirect
GS-436 LC - FR/CF/DE - Act! Insight - Filters panel shows selections for Won/Lost in English
GS-132 TS - APFW - Layouts edited via APFW don't sync to remote databases.
GS-67 APFW - In Contacts there is a large gap on the tabs bar between User Fields and Timeline
GS-17 SDK - Re-assigning custom table does not update edit date

Version 22
Update 1

Issue
Number

Description

GS-2140 NavBar Menu icon for customisation is not visible
GS-2148 APFW - Items missing from v22 update 1 package
GS-2196 Cloud - Chrome - Opening Reports Browser causes log out.
GS-433 Mail merge - Opportunities - Quotes are missing Products, when created on a US act v21.1
GS-1848 APFW - On Custom Table Nav Bar extends into window in IE.
GS-2122 APFW - GS-100 Regression Unable to manually add Outlook address book
GS-2124 Creating "address" field in define fields throws error
GS-2183 TS - Windows - HTML detail editor setting background color to white
GS-782 APFW - Outlook Add-in - When Creating an Activity and attempting to select a date on the mini calendar, it is truncated
GS-2134 User Management - Cannot remove Web API access Permission, from Manager Role User
GS-2200 Pro trial displays MyAct page instead of non-subscriber view
GS-2213 AFW - Chrome - Tools - Act! Email setup button has no effect
GS-2215 Email histories recorded as Subject and Message always display in desktop client as Times New Roman.

Service Packs for Act! v21

Version 21
Service Pack 1
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

GS-1505 Unexpected results running Act! without internet access
GS-1499 APFW- Message 'Object reference not set to an instance of an object' pops up after mail merge via Email
GS-1494 TS - Text entered into 'Details' on Contact Relationship tab appears as Webdings/Wingdings
GS-1487 LC- FR - Process list / Dropdown list needs translating
GS-1482 Licensing - CF - Activation wizard is untranslated
GS-1479 APFW - Download button does not work in E-mail preferences
GS-1478 Licensing - Online Activation button loads form for Offline Activation after applying update 5_3

GS-1240
APFW - Error: "An error has occurred on the server and has been logged. Please contact your administrator if this problem persists. " when going to
Tools>Preferences>Activities in APFW

GS-1238 APFW - Layouts are not saving in Chrome Browser
GS-1237 Custom Tables - Deleting a Custom table causes errors creating New Custom tables or running Check and repair on Database
GS-1229 LC - DE/FR/CF - In Help > About, the Copyright information displays the year as 2017 for Desktop and Web
GS-1220 LC - DE/FR/CF - The prompt advising a Username must be an email address in Offline Clients is untranslated
GS-1213 Beta - APFW - Unable to delete History items (Contact/Group/Company/Opportunity)
GS-107 When synchronising Act! and Google a prompt advises Google Authorization has expired
GS-89 Beta - Outlook - Error "An unknown error occurred, error code: 0x80040154." when accessing Act Address book in Outlook
GS-59 AMA on RDB from apfw database using Web API / Act! Connect Link does not work
GS-43 Cannot activate if Proxy Server uses username/password authentication
GS-42 AD - Added Permissions are not removed when moving user to a new group
GS-27 Insights - LC - DE/FR/CF - Act! Insight Charts and view labels are untranslated
GS-25 APFW - IE/Chrome - Write menu options do not function as expected
GS-16 Outlook - Upgrading Act! to 21.x, "Record History of Received E-mails" is set the same as "Record History of Sent E-mails" in E-mail System Setup
GS-1474 LC - DE/CF/FR - no demo database deployed during installation
GS-1472 LC - "Global Toolbar Options" is in English in v21.0
GS-1236 Unable to create Activity from Outlook add-in when using Outlook 64 bit
GS-1235 LC - FR - APFW - Unable to add activity type in web (FR)
GS-98 APFW - LC - DE - Prompt to configure address book is untranslated
GS-91 BETA - LC - DE - Translation and truncation errors within the Contact Layout 1024 x 768
GS-76 AMA will not work on remote database setup to sync with 'Network Sync over Internet'
GS-66 LC - FR/DE/CF - Activation wizard 1st screen only partially translated
GS-65 LC - FR/CF - Enable Act! Emarketing is untranslated
GS-63 Licensing - LC - DE/FR - Trial expired notification is untranslated
GS-62 Licensing - DE/FR/CF Licensing Wizard is missing translations
GS-60 LC - EU - Dates displayed in Task List are formatted to use forward slashes not dots when using Windows DE
GS-46 LC - Dashboards appear in English, on German and French Locales
GS-45 LC - CF - NPS Survey in-product redirect is incorrect
GS-44 Enabling Act! Emarketing causes error 'The database cannot be accessed' when logging into Act!
GS-41 CF - Untranslated strings in Outlook Synchronisation Preferences window
GS-40 LC - DE/CF - Last Edited filters partly untranslated within Universal Search
GS-34 Cannot run Act! as normal user if registered as Admin
GS-32 LC - DE - Licensing - Act! Getting Started Resource Center hypelink is untranslated
GS-31 LC - Splash screen/Eula and Help About Act! says 2017
GS-30 LC - CF - Licensing - The Company field on the User Registration page has two text labels when completing an Online Activation
GS-29 LC - DE/FR/CF - Licensing - The "Name" text label on the User Registration page of the wizard is truncated
GS-28 LC - DE/FR/CF - APFW - Manage Activity Types window is untranslated
GS-22 LC - DE/FR/CF - Translation error in Email & Outlook Sync Preference wizard
GS-15 LC - DE/FR/CF - Licensing - The in-product link on the final page of the Licensing Wizard is incorrect
GS-13 BETA - LC - DE - The text label "Company" is incorrectly translated on the User Registration page of the Activation Wizard
GS-11 LC - DE/FR/CF - Enable Act Emarketing message untranslated
GS-9 LC - DE - Incorrect translation on Insight Graph
GS-1234 Beta - Groups/Opportunities/Companies - Unable to manually add a single contact
GS-99 Remove the APFW startup view prompt
GS-88 APFW - AMA - Clicking '+' on Campaign Results tab logs user out of database
GS-78 TS - APFW - Work week displays incorrectly if work week start and week start are the same day
GS-69 BETA - History Queue folder still being created

GS-1500
'Leave the activity on the Outlook calendar when an activity is cleared in Act!' doesn't work, the activities in outlook still can be deleted which is cleared
in ACT! after synchronized

GS-26 LC - FR/CF - The Operator dropdown is untranslated when creating a Lookup
GS-19 Beta - APFW - Remote Database Synchronization is always disabled
GS-18 Outlook - Quick Attach "Action List" does not pop up, on Emails from Contacts NOT in Act!
GS-48 SDK - GetHistories on entity lacks null sorting overload
GS-33 LC - DE/FR/CF - Licensing - Wizard navigation buttons are untranslated
GS-24 AMA online check should not ping Google.com or Act.com
GS-23 LC - DE/FR/CF - APFW - Update button and information alt text is untranslated within Tools > Preferences > Activites
GS-20 AMA - EU - Assets Lead Form Telephone Number field is set to US format
GS-12 APFW - Error displays on log-on page as Async is not set to true in default.aspx
GS-1469 BETA - Unable to create new database fields as the dropdown list is blank
GS-1246 AMA does not load on APFW because of failed ping to act.com

Updates for Act! v21

Version 21.1
Update 4
Requires: Pro, Premium, Premium (access via web), Growth Suite

Issue
Number

Description

GS-1771 Added support for the new and more restricted Google authorization scopes enforced for applications which have access to Google user data.
GS-657 APFW - Deleting a group then creating a history can cause user log out
GS-1671 Chrome for Mac - Creating a follow up activity can cause user log out
GS-1689 Google Chrome - Clearing an activity can cause user log-out
GS-1673 APC - Unable to log in if user is disconnected while database is locked
GS-1796 APFW - Outlook calendar sync includes all activities, even if they do not belong to the user
GS-1772 Regional settings with different decimal separators (e.g. Dutch) are not adhered to
GS-1810 Google Integration does not record email history

Version 21.1
Update 3
Requires: Pro, Premium, Premium (access via web), Growth Suite

Issue
Number

Description

GS-550 LC - FR/CF - Activity Type elements not translated correctly
GS-1533 LC - DE/FR - Default language in install drop down does not match OS language
GS-587 LC - FR - Pipeline View button not translated
GS-582 Licensing - LC - DE/CF - Prompt to advise license expired/maximum number of installs has been reached is not translated
GS-567 LC – Splash screen is untranslated
GS-439 FR - The text displayed for the option to receive a notification when a contact does not exist in the database is truncated
GS-429 LC - CF - Act! Update Download Progress is not translated to French
GS-424 LC - DE/FR - The 3 Move Database wizards are not translated
GS-420 LC - CF/DE/FR - Title truncated on 3/3 in activation wizard
GS-419 APFW - LC - DE/FR - Pipeline View option on menu bar not translated
GS-416 Licensing - LC FR/DE/CF - 'Country' is untranslated
GS-415 FR - Some Pipeline View date filter options appear in German
GS-87 LC - DE - Customise menus and toolbars dialog contains truncated text
GS-1617 AMA Target not correct for DE/FR/IE
GS-14 LC - DE/CF/FR - No space between hyperlinked text and plain text in the Activation Wizard
GS-1571 LC - DE - The option for Contact Activity within the Lookup menu is incorrectly translated
GS-1570 LC - DE - The option for "By Example" in the Lookup menu is incorrectly translated
GS-826 Licensing - LC - DE/CF - Hyperlinks in trial expired prompt are incorrectly formatted
GS-608 APFW - French translations don't match Windows in New Activity Recurrence Tab
GS-556 LC-FR-APFW: The prompt box message in administrator is not localized in to French
GS-523 LC - DE/FR - Truncated text on Setup Assistant for WEB
GS-511 LC - DE - Missing Translation on Group Detail View Add Link (URL)
GS-509 LC - CF/FR/DE - APFW - Text truncation display on Contact -> Groups tab
GS-507 LC - FR - APFW - Truncation for the creating Note dialog
GS-505 LC - DE - Tooltip in Scheduling Preferences is not translated
GS-502 LC-FR/CF Truncation issue occur in Advanced Preferences dialog
GS-499 Licensing - LC - DE - The prompt to advise the trial has expired contains text which is truncated
GS-495 LC - DE - Missing Translation on Company Detail View Add Link (URL)
GS-475 LC - DE - Clear button was not translated in Export Wizard.
GS-452 LC -FR - Web login page shows an odd background icon
GS-450 LC - CF/FR APFW- Truncation issue occurred in Insert Note/New History dialog
GS-445 LC - DE/FR - Translation issue in mail merge wizard pages 1 and 5
GS-86 LC- DE/FR/CF - Dialog to edit multiple contact histories contains truncation
GS-74 LC - DE/FR/CF - Licensing - The in-product Resource Center Link points to the US
GS-73 LC - DE/FR/CF - Licensing - Country List on User Registration page is not sorted alphabetically
GS-543 LC - DE/FR - Truncation on Website Admin tool
GS-537 LC - BETA - DE - Installation Complete dialogue following upgrade is partially English
GS-526 Licensing - LC - DE - Misplaced underscore on "Weiter" button
GS-793 LC-FR/DE/CF Truncation issue occur in the outlook Automatic Synchronization schedule dialog.
GS-1588 APC - When syncing an Offline Client schema files are added to the desktop of the Users machine
GS-1559 APC Trials not activating features correctly
GS-1553 APFW - Activity Types Call, Meeting, To-Do, and Other produce an error on Pipeline View
GS-1530 APFW - Remote database sync set wizard has incorrect spellings
GS-1030 Chrome - Lookup - The entire dialog is gone when we click "No" button on the confirm dialog
GS-575 APFW Mobile - Copyright footer on home page for APFW mobile is 2017
GS-137 APFW - Chrome - Web Service Address dialog is truncated
GS-136 APFW - Opportunities - Days in Stage do not update in List view in web
GS-1624 APFW - System Manager role always applied to specific user names
GS-68 APFW - Edit > Replace Field, missing Record Manager option
GS-1603 APFW - Duplicate Note/History records created when clicking OK multiple times
GS-1567 Invalid characters allowed in the new remote database wizard
GS-1565 Back button in remote sync wizard does not work on last page
GS-859 APFW - Select Layout list does not have a scroll function, as it does in Desktop
GS-832 APFW - Activity Types window too small to display icon upload error
GS-804 Win/Web default layouts aren’t the same
GS-784 APFW - Prompts advising on number of incorrect connections allowed to the database
GS-645 APFW - Creating Remote Database via Web, with same name as main database, breaks sync
GS-344 APFW/Win - Error when creating email field with apostrophe in name
GS-336 APFW - Backslash at end of username prevents login via web
GS-325 APFW - Logged out of Web after deleting all contacts
GS-268 APFW - Cannot Delete records on history list with the delete key
GS-1628 APFW - Cannot create Quote from Opportunity via web
GS-93 APFW - Chrome - Password Policy window in System Manager opens with excessive empty space
GS-1600 APFW Admin tool - Correct inaccurate failure message when IIS is not running
GS-1057 APFW - "Unsupported Browser" Linked poorly
GS-1028 APFW- When replaced contents select Contact, click value does not response
GS-1019 APFW - No hotkey in the Schedule Activity
GS-968 Preference for activities should be "call completed" in web
GS-953 APFW: Manage Teams - Create Team - 'Team Membership (optional)' font is not to spec
GS-944 APFW - Customize Columns Dialog will not display by clicking Customize Columns from Tools menu
GS-349 APFW - Icon for Excel in task list is not aligned with other icons
GS-771 APFW - Unable to add a Note to multiple Contacts
GS-677 Licensing - Prompt displays with an unfriendly message if User clicks Refresh Activation with no Internet Connection
GS-129 Licensing - Inaccurate offline time calculation
GS-1563 Trial expired message mentions Act! Premium in Pro install
GS-830 Licensing - Options to Activate license in wizard are not greyed out when the product is activated
GS-829 Licensing - No prompt received to restart Act! after deactivating License
GS-828 Licensing - In the Activation Wizard the in-product hyperlink for "Act! Getting Started Resource Center" directs to the US
GS-774 Licensing - Misleading message when license exceeded
GS-773 Licensing - Incorrect product information displayed in Activation wizard
GS-768 Licensing - Option to Deactivate can be selected in trial mode when no serial number is present
GS-767 Licensing - When in trial mode the status in the License wizard advises your trial has expired
GS-607 Licensing - Within Help > About Act!... the "licensed to" information is missing
GS-197 Licensing - Help > About Act! window shows incomplete information
GS-194 Licensing - After deactivating a serial number, user registration data is not saved in new Licensing UI
GS-1554 Creating a Mail Merge to Microsoft Word from a Lookup does not insert a page break between the first two Contacts letters
GS-569 Outlook Integration - Create Act! Contact uses the 'To' email address instead of the 'From' email address of the selected email by default
GS-100 APFW - Unable to manually add Outlook address book
GS-1471 Google Preferences dialog appears after syncing outlook
GS-1595 Provide option to download Outlook integration on the Synchronize with Outlook menu
GS-786 Invalid link in the Act! Connect page
GS-746 Send vCard not correctly tied to security roles
GS-736 Act! Network Sync Service shows wrong version number
GS-721 Cannot set Act! insight as Startup view
GS-322 The Setup Assistant contains an option to convert v3-v6 databases
GS-1611 Unable to update database currency
GS-1560 Opportunity KPIs don't change with filter options
GS-127 New Contact button shows in Pipeline view in Opportunities
GS-167 Manage Add-ons window uses old icon
GS-72 Change wording on Custom Tables flag under Help > About
GS-998 There is no response after click Contact > Attach > Shortcut in the top menu toolbar
GS-996 Databases can not be opening if splash screen image is not found
GS-405 Company List view needs refresh to see newly promoted companies
GS-392 Goldmine import link needs updating

Version 21.1
Update 2
Requires: Pro, Premium, Premium (access via web), Growth Suite

Issue
Number

Description

GS-269 APFW - Write Letter button not clickable in contact detail view
GS-446 APFW - Welcome page missing from left hand stack menu in new database in web
GS-572 APFW - Pipeline - Opportunities menu is not visible in the top menus when viewing Pipeline
GS-579 APFW - Activities-Cancelling a recurring activity delete prompt in IE still deletes the activity
GS-584 APFW - Notes from contacts show in opportunity notes
GS-1462 ISPA - Not all activity types selected in Sync Prefs sync to Outlook or Google (last type alphabetically doesn't sync)
GS-1511 FR - Online/Offline activation options are reversed
GS-1512 APFW - Navigating to invalid company by ID breaks the view
GS-1523 APFW - The Act! logo in APFW offsets the navbar to the right
GS-1526 LC – FR - License wizard untranslated after applying update 1
GS-1539 Opportunities - Act! becomes unresponsive when changing record manager on opportunity access
GS-1541 APFW - Import is always disabled
GS-1542 Upward_API_Streamer logic does not follow latest 21.0 update logic
GS-1548 Cannot create calculated fields in Opportunities

Version 21.1
Update 1
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

GS-1505 Unexpected results running Act! without internet access
GS-1499 APFW- Message 'Object reference not set to an instance of an object' pops up after mail merge via Email
GS-1494 TS - Text entered into 'Details' on Contact Relationship tab appears as Webdings/Wingdings
GS-1487 LC- FR - Process list / Dropdown list needs translating
GS-1482 Licensing - CF - Activation wizard is untranslated
GS-1479 APFW - Download button does not work in E-mail preferences
GS-1478 Licensing - Online Activation button loads form for Offline Activation after applying update 5_3

GS-1240
APFW - Error: "An error has occurred on the server and has been logged. Please contact your administrator if this problem persists. " when going to
Tools>Preferences>Activities in APFW

GS-1238 APFW - Layouts are not saving in Chrome Browser
GS-1237 Custom Tables - Deleting a Custom table causes errors creating New Custom tables or running Check and repair on Database
GS-1229 LC - DE/FR/CF - In Help > About, the Copyright information displays the year as 2017 for Desktop and Web
GS-1220 LC - DE/FR/CF - The prompt advising a Username must be an email address in Offline Clients is untranslated
GS-1213 Beta - APFW - Unable to delete History items (Contact/Group/Company/Opportunity)
GS-107 When synchronising Act! and Google a prompt advises Google Authorization has expired
GS-89 Beta - Outlook - Error "An unknown error occurred, error code: 0x80040154." when accessing Act Address book in Outlook
GS-59 AMA on RDB from apfw database using Web API / Act! Connect Link does not work
GS-43 Cannot activate if Proxy Server uses username/password authentication
GS-42 AD - Added Permissions are not removed when moving user to a new group
GS-27 Insights - LC - DE/FR/CF - Act! Insight Charts and view labels are untranslated
GS-25 APFW - IE/Chrome - Write menu options do not function as expected
GS-16 Outlook - Upgrading Act! to 21.x, "Record History of Received E-mails" is set the same as "Record History of Sent E-mails" in E-mail System Setup
GS-1474 LC - DE/CF/FR - no demo database deployed during installation
GS-1472 LC - "Global Toolbar Options" is in English in v21.0
GS-1236 Unable to create Activity from Outlook add-in when using Outlook 64 bit
GS-1235 LC - FR - APFW - Unable to add activity type in web (FR)
GS-98 APFW - LC - DE - Prompt to configure address book is untranslated
GS-91 BETA - LC - DE - Translation and truncation errors within the Contact Layout 1024 x 768
GS-76 AMA will not work on remote database setup to sync with 'Network Sync over Internet'
GS-66 LC - FR/DE/CF - Activation wizard 1st screen only partially translated
GS-65 LC - FR/CF - Enable Act! Emarketing is untranslated
GS-63 Licensing - LC - DE/FR - Trial expired notification is untranslated
GS-62 Licensing - DE/FR/CF Licensing Wizard is missing translations
GS-60 LC - EU - Dates displayed in Task List are formatted to use forward slashes not dots when using Windows DE
GS-46 LC - Dashboards appear in English, on German and French Locales
GS-45 LC - CF - NPS Survey in-product redirect is incorrect
GS-44 Enabling Act! Emarketing causes error 'The database cannot be accessed' when logging into Act!
GS-41 CF - Untranslated strings in Outlook Synchronisation Preferences window
GS-40 LC - DE/CF - Last Edited filters partly untranslated within Universal Search
GS-34 Cannot run Act! as normal user if registered as Admin
GS-32 LC - DE - Licensing - Act! Getting Started Resource Center hypelink is untranslated
GS-31 LC - Splash screen/Eula and Help About Act! says 2017
GS-30 LC - CF - Licensing - The Company field on the User Registration page has two text labels when completing an Online Activation
GS-29 LC - DE/FR/CF - Licensing - The "Name" text label on the User Registration page of the wizard is truncated
GS-28 LC - DE/FR/CF - APFW - Manage Activity Types window is untranslated
GS-22 LC - DE/FR/CF - Translation error in Email & Outlook Sync Preference wizard
GS-15 LC - DE/FR/CF - Licensing - The in-product link on the final page of the Licensing Wizard is incorrect
GS-13 BETA - LC - DE - The text label "Company" is incorrectly translated on the User Registration page of the Activation Wizard
GS-11 LC - DE/FR/CF - Enable Act Emarketing message untranslated
GS-9 LC - DE - Incorrect translation on Insight Graph
GS-1234 Beta - Groups/Opportunities/Companies - Unable to manually add a single contact
GS-99 Remove the APFW startup view prompt
GS-88 APFW - AMA - Clicking '+' on Campaign Results tab logs user out of database
GS-78 TS - APFW - Work week displays incorrectly if work week start and week start are the same day
GS-69 BETA - History Queue folder still being created

GS-1500
'Leave the activity on the Outlook calendar when an activity is cleared in Act!' doesn't work, the activities in outlook still can be deleted which is cleared
in ACT! after synchronized

GS-26 LC - FR/CF - The Operator dropdown is untranslated when creating a Lookup
GS-19 Beta - APFW - Remote Database Synchronization is always disabled
GS-18 Outlook - Quick Attach "Action List" does not pop up, on Emails from Contacts NOT in Act!
GS-48 SDK - GetHistories on entity lacks null sorting overload
GS-33 LC - DE/FR/CF - Licensing - Wizard navigation buttons are untranslated
GS-24 AMA online check should not ping Google.com or Act.com
GS-23 LC - DE/FR/CF - APFW - Update button and information alt text is untranslated within Tools > Preferences > Activites
GS-20 AMA - EU - Assets Lead Form Telephone Number field is set to US format
GS-12 APFW - Error displays on log-on page as Async is not set to true in default.aspx
GS-1469 BETA - Unable to create new database fields as the dropdown list is blank
GS-1246 AMA does not load on APFW because of failed ping to act.com

Version 21.0
Update 9
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

GS-1738 Change Google Mail integration to read only

Version 21.0
Update 7
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08969 Improved security of automatic Outlook email attachment
D-09031 Marketing Automation - Check for internet access should not ping google.com
B-12484 Marketing Automation - Update API call to improve logon performance

Version 21.0
Update 6
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-04590 Blank mail merge fields don't collapse if there are two blanks together
D-08079 Merge mail fields don't collapse when blank
D-08220 Mail Merge to printer gives error message
D-08471 APFW - History filters reset when you navigate away from a page and return to it
D-08519 Mini calendar view only displays the first 5 users
D-08539 Mail Merge to email displays [[ACTFIELD_DELETE_ME]] for blank fields if the template contains text and at least one image
D-08663 APFW - Cannot open email attached as Subject, Message and Attachments
D-08677 Navbar customisations are lost after restarting Act!
D-08828 Autosave not working in Companies
D-08832 AMA - Dynamic Group membership does not work when criteria are saved
D-08837 DE/FR - In a new database all 1024x768 layouts are missing translations
D-08890 Mail merge - Email - Contact data is mixed up when two fields are placed on the same line and the first field is left blank
D-08923 Creating lookup of single contact from List View changes the Edit Date
D-08924 DE - Incorrect translation in window 6 of 9 (Record History of Received E-mails) of Email System Setup
D-08941 APFW - Web integration uninstall deletes WebAPIURL; install does not recreate value
B-12447 Add support for AU AMA server infrastructure
B-12482 AMA - Add support for Germany server
B-12003 APFW - Add record count to status bar in Contact and Company List views
B-12173 Windows - Allow 'Create Lookup' from multiple selected groups
B-12479 Re-purpose the 6 month survey to send an NPS survey

Version 21.0
Update 5
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08836 SDK – Developer partners unable to debug application with new obfuscation
D-08785 Opportunities - Act! becomes unresponsive when changing Record Manager on an Opportunity
D-08791 Hangs creating opportunities if limited access is enabled
D-08817 APFW - Outlook Web Outlook integration missing dialog
D-08628 Outlook sending Emails using Alias, not email address, when creating Emails from Act!
B-12430 Improve logic to set API URL in remote databases
B-12398 Add support for AU AMA server infrastructure

Version 21.0
Update 4
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08799 Licenses manually entered with dashes may not work with AMA
D-08798 Act! Reader utility no longer works with v21

Version 21.0
Update 3
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08789 Licensing - some PCs produce an invalid Computer Key
D-08770 AMA API redirect does not work for HPPs
D-08782 Incorrect Currency Displays in New Databases

Version 21.0
Update 2
Requires: Pro, Premium, Premium (access via web)



Issue
Number

Description

D-08670 AMA Advanced Query doesn't work in Web
D-08692 Remove Marketing Automation from Act! Pro
B-12323 Introduce new Act! licensing component (replaces Protexis licensing)

Service Packs for Act! v20

Version 20
Service Pack 1
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-07967 APFW - Re-opening the same activity increases the details font size
D-07966 APFW - Creating an activity with new lines removed the line breaks
D-07965 APFW - Activity Lists are not refreshing after Deleting an activity causing logouts. IE only.
D-07963 TS - APFW - Creating contact with activity tab displayed causes logout
D-07949 Resolve Telerik security vulnerability CVE2017-11317
D-07941 BETA - APFW - Contacts slow to load if large volume of history entries
D-07938 Act! Insight Doesn't Work with Password Policy - UK Version Only - APFW
D-07898 Message ‘There was an error writing to the pipe: The pipe is being closed. (232,0XE8).’ Pop up after mail merge via email.
D-07839 LC - FR/CF -Truncation issue occurs in the first and fifth page of ’Copy/Move Contact Data‘
D-07612 TS - APFW - Columns not sorting on Notes/History tabs of Opportunities.
D-07564 AEM - Call List page missing scroll bar
D-07558 TS - Lookup -> related pane drop down does not redraw after expanding and contracting
D-07543 Lookup - Companies -> Zip code... menu option not localized
D-07387 Global Tool bar turns black when making changes

Updates for Act! v20

Version 20.1
Update 9
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

GS-1771 Added support for the new and more restricted Google authorization scopes enforced for applications which have access to Google user data.

Version 20.1
Update 8
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

B-12324 Introduce new Act! licensing component (replaces Protexis licensing)

Version 20.1
Update 7
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08363 APFW Office integration - Quick attach no longer working in 20.1 update 6
D-08355 Recurring activities sync when outside sync range, and can duplicate on subsequent syncs
D-08283 Premium Plus serial numbers do not update seat count
D-08282 Option to ‘Exclude My Record from History’ on sent emails is not localized
D-08280 New Outlook ‘quick action’ features to manage unattached emails are not localized
D-08295 Users are not sorted when "Hide inactive users" is selected
D-08284 Option to ‘Exclude My Record from History’ on sent emails not staying selected
D-07661 FR - APFW - The reports list page is truncated

Version 20.1
Update 6
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-04587 FR- APFW - Task list view/ Activity Tab - Edit and Delete links are truncated
D-04588 FR- APFW - History list / Tab - Edit and Delete links are truncated
D-04589 FR- APFW - Notes Tab - Edit and Delete links are truncated
D-05105 TS - FR - Text Overlaps Button Edges When Deleting Contacts.

D-05305
TS - When creating a History item and selecting the Type as Other, the follow up button on the local install is greyed out, however it remains active on
APFW.

D-05314 TS - Rescheduling a recurring activity with attachment does not create a rescheduled activity.
D-05316 Windows - Companies - Update linked fields messaging was not updated for "update linked fields" button
D-05338 LC - DE– Browse button is truncated on Save Copy As dialog
D-05488 LC - CF - Truncation in emarketing profile
D-05583 LC-FR-“Post” should be “Code postal” on Contact Detail View.
D-05698 LC–FR-On the Copy/Move Contact Data page, the text can’t be showed fully.
D-05699 LC–FR-On the “Reset Menus and Toolbars” truncation
D-05720 LC-DE- The selection box of “Opportunity (select one)” is misaligned in Act! Emarketing--Webpage dialog.
D-05828 Two same hotkeys “Alt + S” appear in the “Schedule Activity” box.
D-05933 Chrome-User Log out automatically with an error message occurred after using “Attach File…”.
D-06020 LC-FR-APFW: Truncation display on the Activity part on contact detail view
D-07016 Chrome – Dashboard – The activity cannot be deleted when we select “delete all activities in the linked series”.
D-07029 LC-FR-APFW: There should be more space between these buttons and the dialog frame
D-07084 TS - Relate Contact Window cannot be resized.
D-07131 LC-FR: Truncation in Email System Setup Outlook Address Books page
D-07280 TS - Act! Network Sync Service Update refers to Act! Update
D-07326 Lock/Unlock filter slider text needs to be centered as it's topmost currently
D-07367 TS - APFW - DE - Spelling error in Emarketing Opt Out menu.
D-07468 Space needed for easier reading Monthly contact limit
D-07478 Unable to connect to sync server error is incorrect
D-07578 APFW - The “Send At” field displays blank in the “Next Scheduled Email Campaign” section
D-07640 TS - APFW - Defunct 6 month survey appears
D-07653 TS - APFW - Error in Application when trying to change password when 'User cannot change password' is enabled.
D-07675 White icons of ‘Product Reports’ & ‘Opportunity Reports’ appear in New Report dialog.
D-07733 The ‘Favorite’ icon was changed from icon to text after resetting the Columns in the contacts List View.
D-07747 TS - APFW - Deleted Activities in IE do not disappear from list without refreshing page
D-07818 APFW - Calculated fields allow blank if set before choosing "calculated" as field type
D-07824 APFW - Activities - Schedule for dialog displays current user instead of "created by"
D-07828 LC - DE/FR/CF - Pro Welcome Page isn't directed to the correct regional page.
D-07837 Act! Update package (20.0 u5) references ACT2000
D-07838 TS - APFW - Unable to filter task list by keyword in IE.
D-07840 No scrollbar when creating calculated field with long formula
D-07841 TS - APFW - The advanced query open window doesn't always close in IE11.
D-07842 TS - Unable to delete a complete activity series in IE.
D-07843 TS - APFW - When using the 'replace' option when importing into APFW, information that is not being imported is removed from the record.
D-07851 TS - APFW - Company activities tab showing all activities after lookup in IE.
D-07865 TS - APFW - Standard Users unable to create secondary contacts if 'Delete Records' permission removed.
D-07884 TS - APFW - Able to create a remote database from another remote database via Web.
D-07917 LC-DE- Truncation issue occurred on Emarkting Overview.
D-07937 TS - APFW - Attempting to delete an in use opportunity stage gives misleading error.
D-07955 DE - Act! Notification message contains truncated text
D-07979 TS - APFW - Removing a field from a database when included in a 'customised columns' selection causes a logout
D-07985 LC-DE/CF/FR: The help descriptions of all charts are not translated into German or French.
D-07999 TS - APFW - Logged out of web or error message after adding a document to a new contact
D-08000 TS - APFW - Alarms window not appearing after a session times out
D-08040 TS - Old databases open in 20 without needing to update
D-08061 LC - CF/FR –Truncation issue occurred in Select Contacts dialog.
D-08065 LC_FR/DE/CF Truncation issue occurred in Act! Update Details dialog.
D-08071 LC – CF/FR Truncation issue occurred in Contact Merge Options dialog when import database.
D-08080 APFW - IE - Selecting "delete all occurrences" of recurring activities still only deletes one
D-08082 LC-DE Truncation issue occurred on the ‘Create, edit, or delete drop-down lists’ dialog.
D-08084 LC – CF/FR Truncation issue occurred in Opportunity Graph Options dialog.
D-08085 LC – DE/CF/FR APFW - Truncation issue occurred in Opportunity Pipeline Options dialog.
D-08086 TS - ISPA.exe runs at 100% CPU on TS environments.
D-08089 LC – CF ‘Share’ button is not translated to French on Open/Share database dialog.
D-08095 LC-FR/CF/DE – Translation issue occur during the creation of custom tables.
D-08097 LC – FR/CF/DE ‘Delete local preferences’ prompt box is not translated to French/Germany.
D-08098 LC – FR/CF/DE Some contents are not translated to French/Germany in Map Entity Fields page for Custom Tables.
D-08100 LC – FR/CF/DE Translation issue occur in Customize Columns dialog for Custom Tables.
D-08101 TS - APFW - History Result incorrect when sending an aem campaign via Web.
D-08103 TS - Email address from Outlook contact is used instead of email address in Act!.
D-08110 LC – FR/CF/DE The prompt box name – ‘Custom Tables’ is not translated to French/German.
D-08111 LC-FR/CF/DE – The contents of all prompt boxes are not translated to French and German when edit a record in the custom table.
D-08113 LC – FR/CF/DE - Truncation issue occurs in Mail Merge Wizard (7 of 7) dialog when mail merge by E-mail.
D-08115 TS - Upgrading Pro Databases to Premium 20.1 does not always update the Product Tier correctly.
D-08118 LC-DE Truncation issue occurred for ‘This contact is dynamically included in the groups listed below’ on the ‘Dynamic Groups Membership’ dialog.
D-08123 LC – DE/CF/FR The ‘company field’ is overlapped by the field selection box in Define Fields dialog.
D-08124 LC – DE ‘Browse…’ button is wrapped in Import List Items dialog.
D-08129 TS - History has no line break after the Regarding field in preview pane
D-08135 TS - APFW - Unable to schedule an activity series in Chrome when one of the activities is in the past.
D-08151 APFW-Custom Tables-Create a 2 Number fields and a Calculated Numeric field, using the Number fields, in Custom table via APFW gives errors
D-08153 APFW - Custom Tables - Creating a Field in Custom Tables before creating a custom table logs user out of APFW
D-08154 APFW - Custom Tables - Editing a custom table calculated field gives an error.
D-08155 APFW - Custom Tables - Cannot edit custom table field name.
D-08158 APFW-Custom tables-Clicking on Picture field in Custom table Layout Designer for Web gives error

D-08162
APFW-Custom Tables-Create 2 Picture fields in Custom table and add an Image in each of the fields via APFW, last Image added, overrides both
fields

D-08167 APFW - Custom Tables - Industry Template Library option is unresponsive
D-08170 Custom Tables-Creating a Calculated field, based on Numerics, does not validate formula.
D-08200 TS - Web Info tab - Open Browser link uses IE and not default browser
D-08201 LC-FR : Missing translation for “Address” in Contact detail view.
D-08209 Pressing keyboard shortcut Ctrl+F5 when viewing AEM in Act! causes an error: Object reference not set to an instance of an object.
D-08224 Custom Tables - Calculated fields on Custom tables, break Schema export
D-08231 Deleting Series causes popup for delete recurring activity
D-08236 (Chrome) Warning in activity series doesn't let you continue
D-08260 Groups tree doesn't stick when navigating away
B-12006 Add Documents tab option to save selected file locally
B-11493 Add ID/Status to the Create Act! Contact dialog in Outlook
B-11766 APFW - Left align the big button menu
B-10890 APFW - Managing opportunity processes to use same terminology as windows
B-12011 APFW - Reduce Act! icon file size
B-12007 Contact column should display by default on Group and Company history tab
B-12009 Display preferences tabs on two rows
B-12012 Enable 'Look for' field in list views by default
B-12010 Move Lookup > Favorites further down the menu
B-12008 Remove inactive paging controls under the calendar task view
B-12038 SDK - Add event where a contact, group or company is added to an opportunity
B-12036 SDK - Add events where opportunity total is modified or recalculated
B-12037 SDK - Add events where relationship is added to a contact
B-12035 SDK - Add open and close events for the layout editor
B-12039 SDK - Provide consistent event for LayoutLoaded
B-12034 SDK - Record Created events are inconsistent or missing
B-11646 Update Act! Notification text to point at our 'What's Fixed' KB
B-12021 Allow 'Create Lookup' from multiple selected companies (Windows Client)
B-12001 APFW - version numbers displayed should match windows client
B-12057 Add preference to only attach histories to contact and NOT my record on auto-attach histories.

Version 20.1
Update 5
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08102 Using email attachment type 'Email subject, message and all attachments' also adds the email to the history details.
D-08075 When opening an email in Outlook from history, the respond options are missing and it's editable.
D-08052 Unable to schedule database sync.
D-08049 Chrome - New password dialog for "Update Outlook Integration" causes refresh in Chrome and never downloads integration.
D-07998 APFW - Entire contents of email shows in regarding and details column of histories.
D-07996 Address book error appears when sending emails immediately following Act! install.
D-07634 Navigation pane - lookup menu allows input of any data in field name.
D-08132 Using new web Outlook Activity Sync (via API) fails with non-US regional settings

Version 20.1
Update 4
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08077 Allow history creation for emails sent from a user of this database to another user setting not respected.
D-08024 APFW - Custom Tables - Error trying to move individual columns using Customize Columns
D-08013 Outlook Sync can only sync a maximum of 6 activity types
D-07992 APFW Mobile fails to show calendar entry in list, day or month views
D-08015 Quick Attach window shows a previously unattached email.
D-08052 Unable to schedule database sync
D-08049 Chrome - New password dialog for "update outlook integration" causes refresh in Chrome and never downloads integration
D-08047 APFW - Specific Custom Tables schemas don’t load layout
D-08036 Insight API token call is synchronous and it slows first time APC logons
D-08055 Premium Plus license check can lead to degraded performance
D-08003 APFW - Outlook contact and calendar sync fails

Version 20.1
Update 3
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-07977 Unable to mail merge to email using TPL template
D-08027 Shared v20.0 database cannot be accessed until db upgrade is run locally

Version 20.1
Update 2 (included in Update 3)
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

D-08037 AWA error during installation
D-08038 APFW - Mail merge fields not populated when viewing sent ADT template via Outlook

Version 20.0
Update 10
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

GS-1771 Added support for the new and more restricted Google authorization scopes enforced for applications which have access to Google user data.

Version 20.0
Update 9
Requires: Pro, Premium, Premium (access via web)

Issue
Number

Description

B-12379 Introduce new Act! licensing component (replaces Protexis licensing)

Version 20.0
Update 7
Requires: Premium (access via web)

Issue
Number

Description

D-07975 APFW - Creating contact with activity tab displayed causes logout

Version 20.0
Update 6
Requires: Premium (access via web)

Issue
Number

Description

D-04427 APFW - Contacts slow to load if large volume of history entries
D-07948 Resolve Telerik security vulnerability CVE2017-11317

Version 20.0
Update 5
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07771 FR/DE - Insight charts show months in English
D-05340 FR/CF - Some unlocalized text display on a new database
D-07724 FR/DE - Truncation in Delete Recurring Activity dialog.
D-07769 FR - Freeze columns functionality not usable
D-07728 APFW - Login page is not localized
D-05606 APFW - DE/CF the word browse is untranslated after clicking add document
D-07034 FR/DE - APFW: Contact Report can’t be created successfully
D-07774 FR/DE - AEM top menu not localized in APFW
D-07757 APFW - DE/CF there is no response after clicked the login button on APFW login page
D-07776 FR/DE - Call list columns show English when populated
D-07811 DE - Text Cut off on Insight button
D-07807 FR/DE - Add Chart button missing text in Insight

Version 20.0
Update 4
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07651 Insight does not load if WebAPI is on a different domain
D-07632 Windows - History dialog - scroll bar does not appear when text is longer than allocated space
D-07607 APFW - Act Icon is still Blue on Chrome tab
D-07652 Deleting an activity should change edit date

Version 20.0
Update 3
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07585 Act! Insight currency is always dollars
D-07589 APFW - AEM loading performance improvements
D-07596 AEM - Overview screen does not display correctly on all screens.
D-07257 Windows - Closing Act! while AEM views are loading can result in crash
D-07513 Various Swiftpage emarketing features give an object reference error
D-07577 When startup view is Contact Detail, no longer goes directly to MyRecord.

Version 20.0
Update 2
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07406 Unable to register Act! Pro
D-07556 'Contact' and 'Share With' columns can't be added to any list views

Version 20.0
Update 1
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-05438 Changes to history recording on individual emails is ignored.
D-05763 APFW - IE11 - The Alt+L keyboard shortcut is invalid on the "Schedule Activity" page.
D-05808 APFW - Mail Merge > There are no attachment in the received email after sending with the attached document.
D-07309 AEM - Call List loading contacts in batches of 200, missing last batch
D-07487 APFW - Group Name lookup returns all groups.
D-07504 v20 UI - Display issue with dropdown to select lookup field in navbar
D-07509 Insight: On lookup section - Related Tasks "Print Current Screen" is not working
D-07514 APFW - AEM - thumbnails being loaded over HTTP when accessing web via HTTPS
D-07524 APFW - Server Error message displays on Emarketing page after log on AEM.
D-07537 APFW - Cannot remove a document added to the Documents tab
D-07261 LC - Days in Stage fields missing from LC layouts
D-05605 LC - APFW - CF/FR/DE - Text truncation displays on Contact Access tab.
D-05969 TS - LC - Message when upgrading to v19 about new rep2 reports.

Service Packs for Act! v19

Version 19
Service Pack 2
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-05863 APFW - Rich text created in web or windows do not display correctly on the other
D-05855 Act! Address Book Type missing because MAPISVC.inf is in wrong location.
D-05849 The new database can’t be created when we install SQL Server 2012 Standard.
D-05843 APFW - Dates filter-The Dates filter for tabs decreases once each time you click it
D-05839 APFW - Issue with Shift Click multi-selecting in alarms window
D-05837 User can’t use the feature of Emarketing properly.
D-05835 APFW - Edit-> Replace Field: The entire page is refreshed automatically after clicked the 'Cancel' button.
D-05830 APFW - Chrome - Relate Contact - two scroll bars in the bottom two "relate contacts" drop-downs
D-05827 Chrome - Schedule activity from non-activity-related main views causes full screen refresh
D-05826 Chrome - Schedule activity from Dashboard view causes full screen refresh
D-05825 Chrome - Schedule activity from Task List view causes full screen refresh
D-05824 Chrome - Schedule activity from Company detail view causes full screen refresh
D-05823 Chrome - Schedule activity from Group detail view causes full screen refresh
D-05821 APFW - Hide inactive users is not a global setting for Calendar "Select Users"
D-05816 APFW - IE11 - The toolbar of RTF is partially covered by gray area after unchecked the “Add Details to History” option.
D-05810 APFW - Create Company From Contact Greyed Out in IE.
D-05808 APFW - Mail Merge>There are no attachment in the received email after sent an email with the attached document.
D-05801 APFW - Set the Act and Outlook calendar synchronization between each other, Outlook calendar cannot be synchronized to the Act!
D-05799 HPP's need to be able to add more than one subscription serial number on a machine
D-05798 APFW - copying image into note from MS word makes it impossible to save note and causes logout
D-05795 The Act! Application need reboot continuously and cannot be installed successfully.
D-05794 BETA - Act for Web Installation sticks in a reboot loop.
D-05785 BETA - C++ Failed to install error.
D-05784 APFW - Outlook mailbox contacts cannot be synchronized to Act!.
D-05783 APFW - Cannot sync Outlook with APFW installed via IS 2016
D-05781 APFW - Call activities cannot be synchronized to outlook calendar

D-05780
APFW - Synchronize Calendar: 1-way: Sync Act! to Outlook>Advanced Preferences> Select type, I selected the type that did not sync to the Outlook
calendar.

D-05779 APFW - “Synchronize Calendar: 2-way: Sync Act! and Outlook with each other” settings cannot take effect.
D-05774 APFW - Opportunities List View export to excel, there is no data in the excel table.
D-05772 APFW - IE11- The “Private” layout not aligned with the button box in the Record History dialog box.
D-05765 APFW - Opportunity detail view: The control of Probability do not display properly
D-05760 Changing the type of an activity when scheduling sets all dates and times to 'undefined'
D-05758 On the "Act! Diagnostics" Dialog box, the “Change Time Zone” feature still can be used even if we input wrong password for the database.

D-05757
On the "Act! Diagnostics" dialog box, an error pops up after clicked “SQLDiagSnapshot” or “SQLDiagMonitor ” button on the “Server-SQL Diagnostics”
page.

D-05756 On the "Act! Diagnostics" dialog box, an error pop up after clicked “Server Configuration Manager” button on the Server-Server Security page.
D-05755 The “Apply” and “Cancel” button doesn't display after clicked the “Server Settings” button.
D-05754 The introduced place can be edited and the password can’t be changed after clicked “Reset SQL Password” button.
D-05750 Outlook sync history log sporadically deleted during syncs
D-05749 Need new licensing SKU for 19.2 premium/web perpetual
D-05745 The “Next” button can’t be clicked when click back to the previous page.
D-05739 APFW - The words “Automatically update this field without prompting the user” displays non-English language in Update Field page.
D-05728 APFW - New Contact retains Documents tab contents.
D-05725 End User License Agreement- The End User License Agreement displays previous version information.
D-05710 APFW - Clicking on email address in detail view of contact in Chrome v57 does nothing.
D-05707 APFW - Multi Select drop down missing bottom item from list.
D-05695 APFW - Error messages in Event Viewer show username and password in plain text.
D-05692 The default value of “Campaign Date” is not “Last 30 days”.
D-05685 APFW - Chrome - Manage Users - Unable to retain user as a contact when select retain this user’s contact detail after click “Delete User”.
D-05683 APFW - Write>Email message not working in Chrome
D-05682 API no longer validates Business Care entitlement
D-05677 APFW - After multiple incorrect login attempts don't get error saying database will be locked for x minutes.
D-05676 APFW - Error when creating drop down list.
D-05672 APFW - Alarms not appearing after closing tab with alarms window open.

D-05671
APFW - Chrome - Define Fields - The Created Calculated field dialog returns to Home page automatically when click “OK” button in the “Validate
Formula” dialog box.

D-05670 Outlook Integration will fail when Act! run as admin and Outlook open and not run as admin
D-05647 APFW - Able to create a remote database starting with numbers
D-05646 Layout selector prefixes all layout names with "Basic Contact Layout"
D-05643 APFW - Unable to schedule activities if not viewing own calendar in Chrome.
D-05632 APFW - Manager Users cannot unlock/lock database via web.
D-05619 Outlook Activity Sync Deletes Calendar entries from Act!
D-05617 Opt-outs not setting back to false when Download Campaign history
D-05603 Copying and pasting an activity causes an object reference error
D-05602 Act.Outlook64.service should not run on 64 bit machines with 32 bit office
D-05581 Missing column label in Copy Contact Data
D-05573 APFW - When using Edit > Replace, OK button doesn't become active if info pasted into the box.
D-05552 19.1 - Copyright is still 2016 in mobile client.
D-05545 APFW - Sort order on Opportunity list is not maintained on second and subsequent pages.
D-05536 Note preview remains when switching to a company with no notes
D-05517 Prem - Alarms - Some cleared timeless activities are displaying alarms after upgrade to 19.0
D-05516 Prompted to install 'Web API' instead of 'Act Connect Link' at end of Premium install.
D-05468 Social Updates tab gives error on Facebook.
D-05462 APFW - Going to Detail View from a Lookup resets the lookup.
D-05458 Colour Schemes in Act!.
D-05453 APFW - Logged out of database when entering a note after running a report.
D-05358 APFW - Cannot Delete or Duplicate Opportunities in List View
D-05315 APFW - Logging onto APFW with a space as the User Name gives an infinite login display
D-05313 Unable to add new opportunity after changing Weighted Total decimal places.
D-05308 Clicking default checkbox when setting up outlook email makes error pop up
D-05264 Database left locked after closing Tools>Define using 'x' in Chrome.
D-05164 Date and Time information display incorrectly when Export Task List to Excel
D-05133 Original Scheduled date in Schedule Activity dialog is truncated
D-05109 APFW - Chrome - Advanced query from first value does not show operators
D-05050 Installer - Installer does not detect SQL 2016 Standard is installed
D-05005 Spelling error on dialog notifying when no Smart Tasks available
D-04984 APFW - Reports containing German characters in the name do not run
D-04934 APFW - Calendar - Monthly - Navigating with the Arrows does not (always) refresh the Calendar View Correctly
D-04901 APFW - Calendar view - New session reverts to monthly view
D-04789 Chrome - Select the item of “Dates” on Task List page cause a full screen refresh.
D-04767 APFW-When the Company menu is expanded, the Update Linked Contacts menu option isn't grayed out.
D-04741 Chrome - Close a schedule Activity dialog cause a full screen refresh.
D-04733 Chrome - Opportunities - “Adding/Editing a Note record” causes a full screen refresh
D-04730 Chrome - Opportunities -“creating a new activity” causes a full screen refresh
D-04725 Chrome - Opportunities - Add / Edit Product causes a full screen refresh
D-04724 Chrome - Contacts - Add/edit a relationship causes a full screen refresh
D-04723 Chrome - Delete a secondary contact record causes a full screen refresh
D-04717 APFW - Contact - History Tab -- retain data from another contact when creating a new contact
D-04705 Chrome - Contact - History Tab-Editing a history record cause a full screen refresh.
D-04702 Chrome - Contact - Activities Tab-Create new activity cause a full screen refresh.
D-04657 Alarms Dialog - Customer reports Snoozing large numbers of alarms does not work.
D-04641 Facebook page on web info tab coming up with error.
D-04636 Chrome - RTF Toolbar Font Size control sets size to max - cannot reset or change to other values.
D-04599 Missing a space between ''calendar" and "to" on the Advanced Preferences dialog of Synchronize Calendar
D-04405 UK - Registration Wizard localization error - changes "Statement" to "Countyment"
D-04141 APFW - Different Alarm Snooze options between Web and Software client.
D-04092 Images in templates show as attachments when merged through v18
D-03998 APFW - Chrome - When creating a new note, shows multiple fonts as default.
D-03899 Activity Icons - Custom Activity Icons default to Paperclip Icon
D-03890 Activity Icons - Custom Activity Icons default to Black background.
D-03875 Option to hide Universal Search box is ignored after restart of Act!
D-03751 APFW - Advanced Query - Save icon Stretches when leaving value field
D-03569 APFW - Chrome - Customize Column options pop up window is not opened in dashboard
D-03467 APFW - Record History - The behaviour of font and size dropdown selection is not functioning properly
D-03466 Chrome: Record History - On clicking upon 'Theme fonts and Size' dropdown two scrollbars getting displayed
D-03465 Chrome: Record History - Spell check icon is missing
D-03462 Reports - IE10/IE11 - Tabs and options are not the same as in chrome browser for contacts & Gross Margin
D-03461 Reports - IE10/IE11 - Tabs and options are not the same as in chrome browser for Pipe line and sales
D-03460 Reports - IE10/IE11 - Tabs and options are not the same as in chrome browser for histories
D-03459 Reports - IE10/IE11 - Tabs and options are not the same as in chrome browser for Groups
D-03458 Ultrawebgrid-Reports - IE10/IE11 - Tabs and options are not the same as in chrome browser for opportunities
D-03457 UltrawebGrid-Reports - IE10/IE11 - Tabs and options are not the same as in chrome browser for company
D-03315 Calendar shrunk in Reports -> Contacts Reports, calendar size should be same for From and To fields
D-02671 An Error pops up when click save button after removed contact activities tab.
D-02585 KB link in installer error message is incorrect - points to Sage link
D-02582 Calendar banners overlapping.
D-02521 APFW - IE11 - Dashboard: Truncation occurred about OK and Cancel button at the bottom of the filter dialog.

Version 19
Service Pack 1
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04775 TS - APFW - Groups/Companies tab not updating when move through contacts.
D-04898 LC - TS - APFW - Work Week Calendar shows current day as first day of the week.
D-04899 LC - TS - APFW - Cannot change work week viewed using the mini calendar.
D-04924 LC Update Windows Clients with 19.0 EULA - All regions/tiers/languages
D-04925 LC Update Web Client with 19.0 EULA - All regions/languages
D-04931 LC - Update installers with 19.0 Branded Graphics - All tiers/languages
D-04950 LC - APFW - CF - AEM - Send Email Campaign dialog = Untranslated Strings
D-04952 LC - APFW - DE - AEM - Send Email Campaign dialog = Untranslated Strings
D-04968 LC - APFW - DE - AEM - Main Pane in Browsers = Untranslated Strings
D-04969 LC - APFW - CF - AEM - Main Pane in Browsers = Untranslated Strings
D-04976 LC- APFW - DE - Menu bar doesn't show at the top.
D-04989 LC -AEM - incorrect branding on Send Email Campaign confirmation dialog
D-05036 TS - German Silent installer installs English version
D-05038 LC - APFW - DE - Browsers missing Top Menu bar.
D-05179 Pro/Premium/Web (Windows) - Installer does not reliably install .net 3.5 during SQL install - causing install/setup failiures
D-05218 LC - TS - When updating Linked Company / Contact Fields, messaging shown has been changed
D-05295 LC - DE - Truncation in Companies' Contacts Tab Add/Remove Contacts dialog
D-05294 LC - DE - Truncation in Manage Priorities dialog
D-05293 LC - DE - Truncation in Manage Resources Dilaog
D-05291 LC - DE - Truncation in Conflict Alert dialog
D-05289 LC - DE - Truncation - ?
D-05286 LC - DE - Truncation in Outlook Sync Preferences dialog
D-05285 LC - DE - Truncation in Outlook Integration Preferences
D-05284 LC - DE - Truncation in Outlook integration Preferences Sync Contacts Tab
D-05283 LC - DE - Truncation in Google Integration Preferences
D-05281 LC - DE - Truncation in Mail Merge Wizard
D-05280 LC - DE - Truncation in Mail Merge Wizard Select Template page
D-05279 LC - DE - Truncation in Mail Merge Wizard Select Contact page
D-05278 LC - DE - Truncation in Email Setup Wizard E-Mail page
D-05275 LC - DE - Truncation in Email Setup - Editor page
D-05274 LC - DE - Truncation in Email Setup - Attach to Act! Contacts page
D-05273 LC - DE - Truncation in Email Setup - Activity Invitation page
D-05272 LC - DE - Truncation in Google Sync History Options
D-05270 LC - DE - Truncation - Mail Merge Wizard
D-05267 LC - DE - Truncation in Opportunity Graph Options dialog General Tab
D-05352 LC - DE - Truncation occur on Emarketing Log On dialog
D-05351 LC - FR/CF-Truncation on Quick Print-Set Option-Header/Footer Option page
D-05343 LC - DE - Truncation - "evaluation" line on registration screen wraps and cuts top and bottom out of lines
D-05336 LC - DE - Truncation - Search Button multiple areas
D-05329 LC - FR/CF/DE - Truncation display on Tools -> spelling dialog.
D-05328 LC - DE - Truncation - Quick Print - Portrait mode selection
D-05325 LC - FR/CF/DE - Copyright information is not translated.
D-05442 LC - FR/CF -Truncation in Manage Resources Dialog.
D-05448 LC - FR/CF- Truncation occurs on Filter Activities dialog
D-05415 LC - DE - Truncated text in the Set Password Dialog
D-05392 LC - DE - Truncation of "Updating" text in Synchronizing Contacts Preferences
D-05423 LC - DE - Truncated text on Edit Internet Link
D-05424 LC - DE - Truncated Text in Remove Old Data
D-05426 LC - DE - Truncated text Middle Name
D-05418 LC - DE - Truncated Text in Custom Layout Settings
D-05419 LC - DE - Truncated text on Calendar > Activity Preferences
D-05441 LC - FR/CF - Text truncation display on File > Print > Options dialog.
D-05420 LC - FR/CF - An error display when upgrades the prior-version demo database.
D-05445 LC - FR - Delete confirmation dialog button size
D-05447 LC - DE - Truncated text in Import Assistant
D-05372 LC- DE/FR/CF - APFW - Messy code occur when manage permission on Add Permissions dialog
D-05460 TS - “Object Reference not set to an Instance of an object” when attempting to send an email campaign in AEM.
D-05464 LC - DE - Unable to install Premium on German OS, Win 10, Win 7
D-05470 TS - APFW - Cannot attach a file to a history in Chrome.
D-05475 LC - DE - Truncated text on Copy/Move Contact Data
D-05522 19.1 LC & IE anywhere product codes for licensing
D-05495 LC - Update Windows Clients with 19.1 Branded Graphics - All tiers/DE/CF/FR
D-05509 LC - Update Web client with 19.1 Copyright Statement - All tiers/DE/FR/CF
D-05508 LC - Update Windows Clients with 19.1 Copyright Statement - All tiers/DE/FR/CF
D-05519 LC - DE/CF/FR - Missing translation on Installation Screen "Create Installation..."
D-05526 LC - Installer throws dialog boxes which require clickthrough
D-05502 LC - Update installers with 19.1 Branded Graphics - all tiers/DE/FR/CF
D-05492 LC - Update Web Client with 19.1 EULA - DE/FR/CF
D-05498 LC - Update installers with 19.1LC EULA all tiers/DE/FR/CF
D-05501 LC - Update Windows Clients with 19.1 EULA - All tiers/DE/FR/CF
D-05561 LC - DE - CD Browser for Premium does not contain Act! Connect Link feature
D-05562 LC - FR - CD Browser for Premium does not contain Act! Connect Link feature
D-05563 LC - CF - CD Browser for Premium does not contain Act! Connect Link feature
D-05537 Installer - Signatures not consistent across all tiers
D-05546 TS - Act network sync service shows wrong version number.

Updates for Act! v19

Version 19.2
Update 4
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07750 Performance affected by large amounts of rows in the database preferences table
D-07752 APFW - Notes/History font size not displaying correctly in tab list or preview pane

Version 19.2
Update 3
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07200 32bit Act.Outlook.Service.exe shows as 64bit in description. Email histories are not attached.
D-07075 APFW - Editing an Email Sent History via web, deletes the detail section.
D-07223 Chrome-Only Company field updated in Contact details page after changed all linked fields in company details page.
D-07224 APFW - Activities added in Chrome do not save information on details tab.
D-07228 APFW - Line breaks show as double spaced when creating new note/history/activity
D-07074 APFW - Logged out of APFW when trying to send AEM campaign with AEM not signed in.
D-07130 APFW - AEM - accounts without call lists reloads continuously
D-07218 APFW - Automatic logout when click E-marketing in the left navigation pane.

Version 19.2
Update 2
Requires: Pro/Premium

For information regarding Issues fixed in this update, refer to the following knowledgebase article:

Information regarding the release of patches to resolve issues when using Act! with Outlook 2016 and Office 365

Version 19.2
Update 1
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04092 Images in mail merge templates show as attachments when sent via email (resolved for Outlook 2010 users only).
D-05469 Social Updates - LinkedIn tab not working.
D-05959 Chrome - Details entered on a scheduled activity are not saved after clicking OK on the General or Recurrence tab.
D-05968 History detail background colour not displayed in desktop application.
D-06006 Chrome - APFW login button disabled if credentials are saved.
D-06008 APFW - Specific RTF formatting in activity or history details causes logouts
D-06009 APFW - No response when clicking ‘Send an Email Campaign’, ‘Manage My Account’ or ‘Manage Sender Profiles’.
D-06010 APFW - Notes/Histories detail foreground colours not displayed in tab list or preview pane.
D-07012 Windows - vCard import does not extract city, state, zip, or country
D-07014 Chrome - Chrome v59 menu options or dialogs using window.open() method open in a new browser tab
D-07046 Windows - Emarketing - AEM Basic accounts get notification when navigating to emarketing page

Version 19.1
Update 7
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07426 Error messages in Event Viewer show username and password in plain text

Version 19.1
Update 6
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07200 32bit Act.Outlook.Service.exe shows as 64bit in description. Email histories are not attached
D-07223 Chrome - Only Company field updated in Contact details page after changed all linked fields in company details page

Version 19.1
Update 5
Requires: Pro/Premium

For information regarding Issues fixed in this update, refer to the following knowledgebase article:

Information regarding the release of patches to resolve issues when using Act! with Outlook 2016 and Office 365

Version 19.1
Update 4
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-07014 Chrome - Chrome 59 menu options or dialogs using window.open() method open in an new browser tab
D-05700 Out of Memory Errors and Red Crosses in Act!
D-05680 Email History Queue Task becomes unresponsive - emails aren't attached as histories (improves handling of the service and history queue)

Version 19.1
Update 3
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04092
T/S - Images in templates show as attachments when merged through v18
***Addresses defect for Office 2010 users only***

Version 19.1
Update 2
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-05619 Outlook Activity Sync Deletes Calendar entries from Act!
D-05638 APFW - Scan for duplicates causes logout
D-05517 Cleared timeless activities no longer cleared after update

Version 19.1
Update 1
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-05427 LC - DE/FR/CF - An error display when open demo db on environment with office 2010 installed
D-05541 LC - Outlook 2010(64bit) -Cannot sync activities from Outlook to Act!.
D-05577 LC - DE - Missing report templates when trying to open a new report

Version 19.0
Update 7

https://help.act.com/hc/en-us/articles/360024428653
https://help.act.com/hc/en-us/articles/360024428653


Requires: Pro/Premium

For information regarding Issues fixed in this update, refer to the following knowledgebase article:

Information regarding the release of patches to resolve issues when using Act! with Outlook 2016 and Office 365

Version 19
Update 6
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04092
T/S - Images in templates show as attachments when merged through v18
***Addresses defect for Office 2010 users only***

Version 19
Update 4
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04444 LC - DE - Global Toolbar hard line is too long.
D-05292 LC - DE - Truncation in Schedule Activity Availability Tab
D-05288 LC - DE - Truncation - Activity Series Templates
D-05287 LC - DE - Truncation in Preferences Email & outlook Sync tab
D-05277 LC - DE - Missing Transalation and Truncation in Email System Setup Outlook Address Books page
D-05317 TS - APFW - Word addin cannot generate history if act.Web.OutlookWebServiceAddress is defined
D-05356 LC - FR/CF - Truncation display on “Manage Contact Sync Sets” dialog.
D-05346 LC - DE - Truncation - Copy Move Contact Data Dialog
D-05341 LC - DE/FR/CF- Truncation occurs on Filter dialog
D-05339 LC - FR/CF-Text truncation on set password dialog
D-05334 LC - DE - Truncation - Setup Assistant
D-05332 LC - DE/FR/CF - Unlocalized when select database in Outlook Synchronization Preferences Dialog
D-05401 LC - DE - Truncated and hidden text on "Record not found" query dialog
D-05405 LC - DE - Truncated text in Relate Contact dialog
D-05406 LC - DE - Truncated text on Save Copy As
D-05414 LC - DE - Truncated text in Outlook Sync preferences
D-05390 LC - DE - Truncated text in Activity Reminder
D-05421 TS - Error: "Object reference not set to an instance of an object" when attempting to create/edit/write (other template) using the Act! Word Processor
D-05399 APFW - Timeout closing connections after timeout period even if active
D-05417 TS - 64-bit Outlook crashes when trying to send an email (Office 365)
D-05373 Outlook addins - buttons in toolbar do not sync contacts or calendar in 64-bit Office
D-05397 TS - APFW/APC - Create new contact with Relationships tab selected causes logout
D-05375 LC - DE - Truncation on Preferences > Admin
D-05413 LC - DE - Truncated text on Browse button when adding Address Book to Email Setup Wizard
D-05394 LC - DE/FR - The user list is not saved after adding user in Manage Sender Profiles dialog

Version 19
Update 3
Requires: Pro/Premium/Premium (access via web)

Fixes an issue where Mail Merge would fail to function after Update 2 is applied.
Fixes an issue where new Report format (.rep2) files would not appear for databases not located on C: drives.

Version 19
Update 2
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-05342 Error in act.outlook64.service when installed on non-english OS
D-05363 APC - Outlook Integration "Cannot access a disposed object" on second contact sync

Version 19
Update 1
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04352 Customer issue - Mail Merge performs sporadically.
D-04510 APFW - Act.Integration crashes when sending activity invitations
D-04653 TS - Syncing a recurring activity to Outlook creates one extra ocurrence.
D-05122 TS - Outlook Contact Sync doesn't adhere to the defined sync set
D-05156 APFW - Contact Sync throws “Cannot access a disposed object” Error for office 64bit outlook
D-05299 TS - When using the "E-mail Document" button, the path of the attachment is showing in the name of the attachment in Outlook
D-05256 Calendar Invite displays "Object reference not set to an instance of an object" error
D-05251 APFW - Act.Integration is crashing when trying to open preferences (32 bit machines)

Service Packs for Act! v18

Version 18
Service Pack 2 (includes Update 1)
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04544 ActDiag - Clear Out Licences not working
D-04592 APFW - Trial mode web.config entries contain unsecure references to buy now
D-04518 TS - APFW/APC - Returned to login screen when switching between companies.
D-04533 TS - APFW - Custom date range option is missing from web task list/history list when using Chrome.
D-04677 Premium CD Browser needs to refer to Act! Connect Link.
D-04551 TS - APFW - Contact Record Creation Options not honoured when creating contact from company.
D-04532 TS - APFW - Export to Excel in Opportunities not exporting correct list.
D-04562 TS - APFW - Cannot multi select on history list.
D-04610 Upgrade installation - Unable to Open Act when upgrading from 18.1 to 18.2
D-04632 Pro installation follows with a prompt to install the Web API.
D-04633 Web API prompt verbiage references Marketplace.
D-04674 Update package for Premium doesn't install Act Connect Link.
D-04676 AU Premium demo requires update after install.
D-04413 Groups - Lead capture Tab - Rename "Lead Capture" Tab to " Web forms" in Windows and web for Int Eng, FRE, CFR, DE
D-04480 Do not allow more than one subscription serial in Act!
D-04634 Need translated URLs for the new Act Connect page logic.
D-04556 TS - APFW - Notes Tab not refreshing when creating a new contact
D-04297 TS - Opportunities slow to save after upgrade to v18.
D-04515 APFW - Opportunity Lookup icon is disabled
D-04530 TS - APFW - Selecting custom date range just shows today.
D-04531 TS - APFW - Attempting to set a custom date range causes APFW to hang in IE.
D-04542 TS - APFW - Second opportunity being created when adding product to an opportunity in Chrome if done from the drop down menu.
D-04541 TS - LC - Applying changes made in Preferences gives Object Reference error
D-04645 Manage Users -Web API permission display name is " ||Permissions_MAX64=Web API Access|| "
D-04513 LC - WEB - After selecting a Favorite Report, the lower grid blanks out.
D-04523 APC - IE11 - Non-Secure content prompt for IE11 when navigating to APC Logon page
D-04524 APC - IE11 - Non-Secure content prompt for IE11 when navigating to Opportunity List View
D-04525 APC - IE11 - Non-Secure content prompt for IE11 when navigating to Group List View
D-04527 Web - Default Web Info links need to be secure.
D-03909 APFW - Calendar- Cleared Activity Preference Set To Grey, but Showing Strikethrough
D-04640 TS - APFW - Unable to grant calendar access using Chrome.
D-04652 TS - APFW - Cannot delete entry from drop down list in Chrome.
D-02506 APFW - IE11 - Define fields: The size of vertical scroll bars needs adjust in calculated define fields dialog.
D-04416 TS - APFW - 'Location' field missing from customise columns on activities tabs.
D-04667 Creating a Contact from a Company takes user elsewhere.
D-04678 Selecting a Contact from the Group tab goes to the first contact in the list.
D-04679 APFW - Selecting a Contact from the Company tab goes to the first contact in the list.
D-02748 Move DB retains a duplicate copy of supplemental files in original location
D-02664 History is not be generated after make some changes to the calculated field when the calculated field history generator is enabled.
D-04620 Emarketing - Object reference Error when trying to use AEM with expired token.
D-04276 LC - German - Export Wizard has funky button overlap.
D-02665 User defined activity type cannot display in History List -> Types filter -> "Activity Histories".
D-04666 LC - APFW - The prompt of Web API installation is untranslated in French, French-Canadian, and German
D-04474 Using VCR Arrows and then peforming a browser refresh refreshes to another contact in the lookup.
D-04672 LC-DE- Web- Menu bar doesn't show at the top
D-02719 SAPM: Start Time Field Set to Server Timezone for Follow Up Activities
D-02700 SAPM: The previously selected criteria cannot be removed after deselecting previously selected criteria and saving the group.
D-04448 ACC - Performance - actApplication_CurrentOpportunityChanged fires multiple times
D-04560 TS - Default filters in Opportunities show 'None' for stage instead of 'All'
D-04648 TS - APFW - Tools > Customise Columns doesn't work in Opportunities list view.
D-04659 TS - APFW - Clicking to create a new Opportunity refreshes the current Opportunity view.

Version 18
Service Pack 1
Requires: Pro/Premium/Premium (access via web)

Issue
Number

Description

D-04085 Web - Relationship details box size is too large, requires scroll bars.
D-03782 APFW-Dashboard- Deleting the same activity from different browsers doesn’t show a proper error message
D-03913 Framework error on Exiting Act
D-04161 APFW - Calendar - mini calendar always uses the server date and time for the mini calendar funtions
D-04206 APFW - Calendar Recap list - Any Calendar view - Recap item link will not open the related activity.
D-04164 APFW - Cannot tab out of County field when creating a new contact.
D-04193 APFW - Can't select a contact from the task list if the contact's name is blank.
D-04218 APFW:An warning message pops up when trying to Send to Act a note, history, or activity.
D-04217 Scratchpad Web needs branding update
D-04184 APFW - Activity text colour is not displayed in task list on web.
D-04238 APFW - Calendar - Any view - Timezone Inconsistencies
D-04146 APFW - Chrome - Session Timeout does not present "Continue" dialog and creates redirect loop
D-04115 TS - Define Sync Set button doesn't work when downloaded from Act For Web.
D-04233 APFW - Navigating to Calendar View logs off user not running on English language Windows OS.
D-04180 Web - Write Letter generates error when using Act Word Processor
D-04226 APFW - Chrome mostly - startup preferences aren't honored if you close the browser.
D-04210 APFW - When "Daily Calendar" is selected as the start-up view , it is displaying monthly view calendar instead of Daily view calendar
D-04188 Open Database dialog deformed on FR/CF
D-04235 Blank mail merge fields don't collapse if there are two blanks on the same row.
D-04293 APFW - When encountering a Notes details field with invalid characters, Web Clients are logged out.
D-04230 MOBILE - Cannot dial phone number containing country code since it is not preceded by "+" sign
D-04213 Notifications download message is confusing.
D-04284 CF - Registration Wizard page 4 has untranslated text.
D-04194 DE - LC - Exporting calculated fields causes an error in the export wizard.
D-04303 Create contact while opps tab is open crashes APFW
D-04191 TS - Dropdown value not saved - Windows
D-03682 MOBILE - After clearing text in search field, scrolling in any view is disabled on iPhone with iOS 9
D-04414 Web - Internal Server Error 500 after upgrade to 18.1 from 18.0
D-04365 TS - APFW - No scroll bars when adding an opportunity to companies.
D-04337 BETA - Web API installation is not localised
D-04324 CF- LC - Clear Activity View has display issues.
D-04317 CF display issues -Emarketing View
D-04346 CF - translation change needed for Include sub Groups on Group List.
D-04319 APFW - Opportunities - Email button brings in the wrong email address
D-04318 TS - APFW - Images in a layout get put to the front after upgrading a DB from v17.1 to v18.
D-04353 German -Scheduler Wizard has two pages with display issues.
D-04359 BETA - DE - Some Company tabs not translated
D-04336 DE - Update CD Browser Links.
D-04335 FR - Update CD Browser Links.
D-04351 German - Kontakte synchronisieren view has a couple display issues.
D-04374 BETA - DE - Manage Subscription option uses US redirect
D-04370 BETA - Lookup of Favourite Contacts locks the Contact Detail view
D-04402 T/S - APFW - IE only - Can't select item from Alarms dialog list.
D-04349 TS - Cannot set a default value on selected fields.
D-04345 TS - Lookup displays correct number, but incorrect groups from a lookup
D-04103 T/S - APFW - No scroll bar in Alarms window.
D-04338 BETA - FR - Alarms dialogue 'show/hide more details' text overlaps button
D-04341 BETA - FR - Scheduling dialogue text to use a banner is truncated
D-04342 BETA - FR - Open database dialogue buttons are truncated
D-04369 BETA - DE - Manage Add-ons has untranslated buttons
D-04361 BETA - DE - Contact Layout 1366 x 768 not translated
D-04356 German -Sync panel Wizard Home has display issues.
D-04357 German - Two Remote Create pages have display issues.
D-04355 German -Update Salutation dialog has display issue.
D-04360 BETA - DE - Up button when viewing divisions or subgroups is too small for text
D-04404 Minor upgrade needs to check for slipstreams.
D-04388 APFW - Can't Log In To Web On German Upgrade
D-04430 German - Preferences > Act! E-mail Editor button truncation issue.
D-04395 German - Preferences > Act! E-mail Editor truncation issues.
D-04393 German - Preferences > Calendar & Activities > Calendar Preferences dupe line issue
D-04394 German - Preferences > General> Salutation Preferences display issues.

D-04311
TS - Selecting multiple Companies in Company List view, or Groups in Group List, does not populate contact emails when selecting Write > Email
message

D-04166 Call List - Last updated field is using UTC +7 when using time and now users profile settings
D-04196 APFW - Cannot multi-select on task list.
D-04220 TS - Unable to create new layout tab with a name that has already been used.
D-04224 Win - If the user has not verified their primary AEM email address, Send an Email Campaign will throw an Obj Ref Error, not a friendly message.
D-04189 French Nav Bar defaults to scrunched up.
D-04237 New In-product URLs Required for the Act! Connect View
D-04290 Per Andrew change text color in navbar for better contrast
D-04066 APFW - Timeless activities not displayed in calendar view.
D-04292 APFW- Chrome - Add selected to Company/Group/Delete selected contact do not function.
D-04354 German - Registration Wizard Info page has display issue.
D-04363 BETA - DE - Preferences dialogue has a number of truncations
D-04371 BETA - DE - Calendar preferences contains Monday twice
D-04364 BETA - DE - Truncation in various menu options

Updates/Hotfixes for Act! v18

Version 18.2
Update 6
Requires: Pro/Premium

For information regarding Issues fixed in this update, refer to the following knowledgebase article:

Information regarding the release of patches to resolve issues when using Act! with Outlook 2016 and Office 365

Version 18.2
Update 5
Requires: Act! Pro, Act! Premium, Act! Premium (access via web)

Issue
Number

Description

D-04092
Images in templates show as attachments when merged through v18
***Addresses defect for Office 2010 users only***

Version 18.2
Update 4
Requires: Act! Pro, Act! Premium, Act! Premium (access via web)

Issue
Number

Description

D-05027 Web Client - Activities 'Scheduled with' did not navigate to the correct Contact
D-05028 Web Client - History List Contact Links do not navigate to the correct Contact
D-05029 Web Client - Search Results Contact Links do not navigate to the correct Contact
D-05030 Web Client - Calendar displayed "date here" instead of the proper date
D-05031 Web Client - Cannot change work week viewed using the mini calendar
D-05032 Web Client - Work Week Calendar shows current day as first day of the week.
D-04922 Licenses now support more than 500 seats
D-04941 Saving Preference changes would fail in German, French, and French Canadian products

Version 18.2
Update 2
Requires: Act! Pro, Act! Premium, Act! Premium (access via web)

Issue
Number

Description

D-04873 Invalid ChartFX Gauges License error on dashboard component
D-04297 Opportunities slow to save

Version 18.1
Update 5
Requires: Act! Pro, Act! Premium, Act! Premium (access via web)

Issue
Number

Description

D-04872 Invalid ChartFX Gauges License error on dashboard component
D-04692 Opportunities slow to save

Version 18.1
Update 3
Requires: Act! Premium (access via web) SP1

Issue
Number

Description

D-04192 TS - APFW - Dropdown value not saved to database
D-04319 APFW - Opportunities - Email button brings in the wrong email address
D-04371 DE - Calendar preferences contains Monday twice
D-04487 APFW - Contact List View Customize columns does not function
D-04493 CF/DE Web - Add Document button doesn't work.
D-04495 CF-Preferences- Untranslated line on Calendar Preferences
D-04496 CF/FR-Preferences- Display issues on Composing options.
D-04497 CF-Preferences- Display issues on Dialer Preferences
D-04498 CF-Preferences- Display issues on Record Creation Options
D-04499 CF-Preferences- Display issues on Composing options Signature dialog
D-04502 DE - WEB - CHROME - Can't Access Web FORMS Tab from Web Client
D-04504 DE/CF - WEB -Favorites column doesn't show on Reports view
D-04505 Internet Sync Service needs to check syncconfig xml periodically to include new databases.
D-04508 LC - APFW - Errors displayed when Installing Act! Integration in French, French-Canadian, and German

Version 18
Update 7
Requires: Act! Premium (access via web)

Issue
Number

Description

D-04245 APFW - Calendar - Any view - Timezone Inconsistencies
D-04187 APFW - Calendar - mini calendar always uses the server date and time for the mini calendar funtions
D-04229 APFW - Navigating to Calendar View logs off user not running on English language Windows OS.
D-04249 APFW - Remove redundant Today button
D-04178 APFW - Schedule ActivityDialog - Dialog pulling server time instead of client time.
D-04186 APFW - Today button on calendar takes you to the wrong date.
D-04182 Change filestreams in licensing to be more friendly in large hosted environments

Version 18
Update 6
Requires: Act! Pro, Act! Premium, Act! Premium (access via web)

Issue
Number

Description

D-04113,
D-04114

Web - Chrome - Advanced query feature can’t be used with Chrome.

D-04119 Web - Companies List View - cannot export to Excel
D-04120 Web - The list of contacts associated to Company-A are actually the contacts associated with Company-B.
D-04122 Web - Calendars - Some time zone features would log off the customer.
D-04129 Can’t email a Document listed in the Document tab
D-04131 Web - Cannot filter histories by type in History View and all History tabs
D-04150 Web - Performance - Notifications polling is every three seconds s/b 2 hours

Version 18
Hotfix 5
Requires: Act! Pro, Act! Premium, Act! Premium (access via web)

Issue
Number

Description

D-04024 Fixes an issue where using the Global Toolbar Email command did not populate the TO: field with the taget Contact email addresses.
D-04025 Fixes an issue where Contact > Edit > Replace would fail on secured servers.
D-04034 Yes/No fields will no longer be removed from a Layout after editing.
D-04035 Fixes an issue where Yes/No field types could not be renamed.

D-04037
Fixes an issue where focus on a new Contact was lost when saving, or when triggering an automatic save through another action. E.g., adding an
Activity.

D-04039 Re-enabled email commands for Chrome users. These users can set their email client preferences to “Use default email”.

Version 18
Hotfix 4
Requires: Premium (access via web)

Issue
Number

Description

D-03988 APFW - Logon - incorrect message displayed after third Web logon failure due to credentials

Version 18
Hotfix 3
Requires: Premium (access via web)

Issue
Number

Description

D-03983 APFW - Contacts - Histories and Documents Tab - Navigating to histories tab Crashes APFW
D-03980 APFW - Calendars - Time zone displays the Log on screen when using custom virtual directories.

Version 18
Hotfix 2
Requires: Pro/Premium

Issue
Number

Description

D-03965 Fixed a Web Client issue with the Opportunity Views for databases that did not yet contain any Opportunity records.
D-03969 Fixed a redraw issue in the Contact Detail view when navigating through Contact records.
D-03961 The Web client session will no longer end abnormally when creating the first Opportunity in a database.
D-03959 Act! 17.x for Windows customers will now see version 17 related Welcome Page content instead of version 18.
D-03960 Act! 17.x for Web customers will now see version 17 related Welcome Page content instead of version 18.

Version 18
Hotfix 1
Requires: Pro/Premium

Issue
Number

Description

D-03473 Mobile - Fails to call contact when selecting "Call Phone" or selecting any phone number field on iPhone
D-03848 Some dialogs not responding on Windows Server 2008 R2
D-03858 Resizing the entire Call list tab does not resize the detail window and no scroll bar appears
D-03860 APFW - Task List - No Option To Export to Excel
D-03861 APFW - Chrome - Duplicate Popup Checker is in Loop
D-03869 Error message is squished when licensing errors out
D-03878 When "Daily Calendar" is selected as the start-up view, it displays “Monthly Calendar”
D-03885 Chrome: Act emarketing logon page is not getting loaded prior to logging into AEM account
D-03891 APFW - Preferences - Cleared Activity Display Preference Not Functioning As Designed
D-03902 APFW - Hosted Welcome Page Trial mode should use https, not http
D-03908 Resizing the application window does not resize the Call List detail window, no scroll bar appears
D-03910 Notes - Attaching a document to a note throws an object reference error
D-03918 Removing new AEM permissions still permits the majority of AEM functions
D-03929 APFW - Opportunity Detail Navigation broken

Service Packs for Act! v17

Version 17
Service Pack 2
Requires: Pro/Premium

Issue
Number

Description

103215 TS - Remote database syncs all attachments and ignores sync set
103598 Act! Update Details dialog help link for "Learn how to back up a database" does not function
103747 Timeout retrieving Business Care tier on Act! first startup.
103898 Basic Lead Capture creates Contacts that appear as blank records if email is not a displayed field.
103975 New DB Layouts not created for non-US installs
103994 Failure in AEM Signup clears dialog
104136 AEM View offline content does not reliably display when server not accessible.
104149 AEM Profile data for Monthly Recipients not updated after Campaign Send
104159 Unsupported Browser page does not size for device
104160 Unsupported Browser page contains label for Version but provides no version data.
104165 APFW Installer prompts twice for install region.
104184 UK In-product Marketplace only displays offline content
104365 APFW - Calendar - New created activity is not displayed
104411 Starting Network Sync app always requires Admin mode to function properly.
104422 AEM Signup dialog allows blank country as result of non-matching MyRecord country value
104481 TS - APFW: Apostrophe in Subject Line of AEM Message Causes Blast to Hang
104521 TS - Option to Export to Excel in Tools menu grayed out in Act! Premium (access via web)
104554 APFW - Can't See Activities on the Weekly/Daily Calendars in Web
104564 TS - Email invites Via APFW give error when sent to a user.
104596 APFW - Unable to delete Notes, Activities, Documents and History
104611 APFW: Unable to logon Act! Premium (Web)
104677 TS - APFW - Activities show at wrong time slot in Daily and Weekly views in IE.
104718 APFW: For schedule activity webpage dialog, resources dropdown is not functioning at all
104737 TS - Invalid AEM Access Token Causes Error After Restoring a Database Backup
104746 APFW - Regression - Advanced Query dialog Type/Field/Operator menus are empty
104855 APFW - Clicking Yes on Install Act! Scratchpad sub-dialog does nothing
104867 Error Message while Exporting the database from another database
104918 TS - AEM - After clicking OK to send Email, Cancel option does not work.
104927 APFW - Update Email Campaign History - " An Error has occurred in the script of this page"
104928 APFW - Opportunities - Detail View - Status Options are completely missing
104935 TS - APFW - Multi-select dropdown lists are unusable unless Compatibility View is enabled in IE
104938 APFW - Opportunities - Stage dropdown is nonfunctional on the Opportunity List view
104978 APFW - Contacts-Relationships-Customize Columns: "Move down" button label wraps
104987 TS - APFW - Adding Field to Layout in APFW adds %20 instead of a 'space'
105020 APFW - Tools > Print does not print.
105036 APFW - IE10 - Contacts - New history - Attach button by default disabled
105056 APFW - IE 10: Contact - Send vCard: Clicking on "Install" button does not download file
105074 APFW - Secondary Contacts: Duplicate data from main Contact's primary fields not functioning
105092 If one invitee of an Activity declines an invite, the activity is automatically declined for all.
105124 APFW - Contact-Relationship-scroll bars display issue
105137 TS - APFW - Templates saved locally via web give error when merging.
105141 TS - Private label missing from tick box on Create New Note window.
105145 APFW-Contact-> "Create contact from company" has to be removed from the contact view
105223 APFW - Failed to create a Web form with error message.
105332 APFW-Opportunities-Add Product: Products list need refresh to show new record.
105357 APFW - Calendar - Activity created using the "Use banner" option is not displayed in the Calendar
105376 APFW - Opportunities - Unable to add URL or shortcut to folder path in the documents tab
105395 APFW - Activities: Selecting "In the future, do not show this message" throws an error
105417 APFW-Groups-Lead Capture: OK button does not work in Create Web form webpage dialog.
105419 TS - Changing a company name causes all linked contact fields to be updated without prompting.
105430 Google Integration cannot be initiated with Tools > Integrate with Google menu commands.
105433 APFW - Clicking Yes on Install Act! Scratchpad sub-dialog does nothing
105434 TS - APFW - IE10 - Multi-select dropdown lists are unusable unless Compatibility View is enabled
105440 Subgroup names in Send Email Campaign Group menu items are not sorted.
105443 APFW-IE10-Contact-Secondary Contact: Error message displayed when closing Link to Company
105447 APFW - IE10 - Contacts - Link contact to company is only working the second time
105448 APFW- Contact list view-Customize Columns-Selecting fields and clicking OK throws an error
105450 APFW - IE 10: Opportunity - Contact tab is not selected by default
105455 APFW - IE 10 - Advanced Query- Opening a saved query doesn't create a lookup.
105461 APFW - IE 10: Relationship tab: After zooming, page is refreshed without selecting relationship tab
105489 APFW - Calendar - Clicking on the calendar results in an error
105490 Tabs in Opportunities Detail view increase in size after every refresh
105491 APFW - Calendar - Filtering the calendar by USERS eliminates all of the activities completely
105492 APFW - Calendar - Clicking on the SHOW PRIVATE check box results is error message displaying
105493 APFW - Calendar - Clicking on the SHOW Cleared check box results is error message displaying
105494 APFW - Calendar - Click the left of right arrow on the monthly display changes the monthly bar color
105496 APFW - Calendar - Monthly view - color distinction for the current date needs formatting
105497 APFW - Calendar - Unable to delete an activity by selecting the red "X" on the calendar displays
105499 APFW - Calendar - Weekly View - Icon for each activity is missing
105500 APFW - Calendar - Daily, Weekly, Work Week views - layout needs alignment
105501 APFW - Calendar - Weekly View - The right arrow needs to be moved
105502 APFW - Calendar - Weekly & Work Week Views - Dates are hyperlinked but don’t do anything
105503 APFW - Calendar - Weekly View - Days should be outlined
105504 APFW - Calendar - Weekly View - No vertical Scroll bar
105505 APFW - Calendar - All Views - Adjust the placement of the time zone control

Version 17
Service Pack 1
Requires: Pro/Premium

Issue
Number

Description

102131 “Actual Close Date” field doesn’t change when execute “Schedule->Run Smart Task->Update Status” from the Closed to the Open status.
102770 Calculated Fields: When selecting date field the order of fields is random
103310 Help link in the Mail Merge Wizard needs to be updated and linked to a topic
103418 Opportunities Dashboard - Closed Sales to Date 7, 30, and 90 days filters not working correctly
103598 Act! Update Details dialog help link for "Learn how to back up a database" does not function
103658 Cannot get into Calendar after deleting top contact in list view
103680 Using Save as in Word 2013 only allows .doc, .rtf, .htm, and .txt file types
103772 APFW- Field data blanks after linking contact to a company
103780 Names with suffixes and prefixes are not properly parsed.
103784 When saving a merged Word document the save box appears twice.
103858 When an attachment is deleted in Outlook and sync to Act the activity is getting deleted in Outlook as well as in Act.
103872 Mobile: IOS7: Cannot add company to contact.
103873 '&' not accepted in value for a dynamic group criteria in APFW.
103895 Copy and paste from list view to Excel/Word/Notepad even as restricted user.
103898 Basic Lead Capture will create Contacts that appear as blank records where email is not a displayed field.
103915 Private slider feature is not available while creating the private companies via the Sage ACT! Mobile web site
103941 Google attachments of history are still going to users even when the option is unchecked
103942 Manager Sender Profiles - All fields wrap on large amounts of text
103978 APFW: Invalid page number display in Contacts to select from lists.
103987 Save As dialog displays twice while saving a document.
103988 APFW: Successful message displayed when send an AEM email campaign failed.
103989 Successful message displayed when send an AEM email campaign failed.
103994 Failure in AEM Signup clears dialog - would be nice to redisplay the signup form if the customer wants to try again.
104011 Print Opportunity from the right click menu prints wrong opportunity
104047 Contact Record Manager not retained when typing the first character
104075 Advanced Query Annual Event Within Next days does not work more than one annual event in the query
104090 Change text on the Mail Merge Wizard first and last screens
104106 Unable to attach file in Insert Note dialog under Notes tab
104124 The 'Free Form' phone format cannot always be selected as default.
104136 AEM View offline content does not reliably display when server not accessible.
104145 Linked Yes/No fields not updating
104148 AEM VIEW profile still shows account id after AEM user logs out.
104149 AEM Profile data for Monthly Recipients not updated after Campaign Send - logoff/logon required to refresh
104164 APFW - If you sort contact list view by clicking the column header in web browser then sort option from tools menu is ignored.
104165 APFW Installer prompts twice for install region.
104167 Preferences are cut off due to stacked tabs
104168 Export Task List to Excel should export text not images
104176 'Unable to retrieve Schema Metadata' opening/creating a database when windows set to Turkish
104177 Unable to restore back-up file using the correct password from a back-up create by the scheduler
104181 Type-ahead in Activity/History/Note dialogs
104182 Network sync service says upgrading v16.000 to v16.000 in v17.
104194 Cannot re-index database in ActDiag v17
104212 Object reference not set to an instance of an object error message displayed when send campaign to empty opportunity.
104218 Disabling Professional Mode for the Contact Timeline makes the feature unusable
104223 MS outlook: “outlook synchronization preferences” window display issue
104253 Google Integration Broken after 2.0 API Deprecation
104255 Can't activate Web on Windows 8.1 Pro
104263 APFW - Opportunity Pipeline Options Assign Colours Window has no scroll bars.
104275 APFW -Logged off application instead of prompting for Act! Emarketing Login
104285 APFW: Two Browser Windows Are Opened from iFrames in Web Info Tab
104286 APFW: Failed to send an email campaign with error message "We are unable to send your email campaign..."
104289 Web gives no visual indicator that Call list buttons are disabled.
104294 APFW: Web client logoff after click "Refresh" icon in Emarketing tab.
104296 Cannot open database when PAD file has been edited with HOST in uppercase.
104308 Multi-select is not working properly in the drop down field in Detail View screen
104320 Error Loading Page When clicking the Pencil icon for editing a History item from Premium Mobile
104321 Act! emarketing for web Manage Account screen takes 1+ minutes to open
104351 Blank screen is displaying in browser compatibility mode
104355 Trying second time to create a field without closing the define fields window - user is unable to see the existing drop down list.
104397 Act! won't install on Windows XP Pro SP3 or Windows Vista with SQL Server 2008 R2
104399 Documents Tab - Only show file or folder name in Name column
104401 Installation fails on Windows 8.1 using Win build.
104402 Installation failed on Server 2012/Server 2012 R2 using Web build.
104411 Starting Network Sync app always requires Admin mode to function properly. Enable always admin mode.
104412 APFW - ACT.Integration stopped working when "Sync Calendar with Act! Premium (web)" in outlook using web add-in
104414 Global Toolbar Customization - Enable Show/Hide for the Global Search Field
104416 When changing views - the toolbar drawn often includes a copy of the previous view's toolbar at the end of the current view's toolbar
104419 Google Calendar Sync throws Obj Ref errors
104420 Install can't be run from network due to SQL Server extracted files
104422 AEM Signup dialog allows blank country as result of non-matching MyRecord country value - should not allow blank value
104423 AEM Manage My Account link throws server error - takes 30 seconds to display/shows wrong page
104425 Web Setup fails on 8.1x64 installation due to incomplete DotNet setup
104431 AEM View: Columns Get Truncated When Resizing Columns and Panes
104446 Opportunities tab:Right pane buttons were not getting displayed in the Manage Product List page.
104458 Installing the new build by uninstalling the old build throws an SQL error

Updates/Hotfixes for Act! v17

Version 17.2
Update 3
Requires: Pro/Premium SP2

Issue
Number

Description

D-04695 Opportunities slow to save

Version 17.2
Hotfix 2
Requires: Pro/Premium SP2

Issue
Number

Description

D-03150 Swiftpage Emarketing Plugin Is Not Available After Upgrade to 17.2
D-03320 Send Email Campaign Window Crashes Act! in a Database with more than 158,000 Companies
D-03934 APFW - Detail Views Fail to Render when a Deleted Field Remains on the Layout

Version 17.2
Hotfix 1
Requires: Pro/Premium SP2

Issue
Number

Description

D-02983 No histories created are linked to the contact or company the opportunity is linked to.
D-03028 On closing act windows client, "object reference not set to the instance of an object" error message is displayed
D-03131 Act! crashes when adding a document to a contact
D-03150 Swiftpage emarketing plugin not available after upgrade to 17.2
D-03196 APFW: Chrome - Data Missing in the Square Frame in Contact and Opportunity Detail View
D-03279 Act! crashes on clicking upon documents tab and while attaching a file in notes tab
D-03796 Creating a New Opportunity Does Not Associate the 'New Opportunity' History with the Opportunity's Contact(s)

Note: In addition to the fixes mentioned above, this hotfix also contains a new Act! Premium (access via web) calendar control that improves calendar
functionality when accessing the calendar via the web.

Version 17.2
Windows 10 Document Tab Fix
Requires: Pro/Premium SP2

Issue
Number

Description

D-03279 Act! crashes when trying to use the documents tab or when trying to attach a file to a note when using Act! on a Windows 10 computer

Note: For more information on this issue, refer to the following knowledgebase article:

Act! crashes when trying to use the documents tab or when trying to attach a file to a note when using Act! on a Windows 10 computer
Answer ID Act! crashes when trying to use the documents tab, open history attachments, or when trying to attach a file to a note when using Act! on a Windows
10 computer

Version 17.1
Hotfix 4
Requires: Pro/Premium SP1

Issue
Number

Description

D-03279 Act! crashes when trying to use the documents tab or when trying to attach a file to a note when using Act! on a Windows 10 computer

Note: For more information on this issue, refer to the following knowledgebase article:

Act! crashes when trying to use the documents tab or when trying to attach a file to a note when using Act! on a Windows 10 computer
Answer ID Act! crashes when trying to use the documents tab, open history attachments, or when trying to attach a file to a note when using Act! on a Windows
10 computer

Version 17.1
Hotfix 3
Requires: Pro/Premium SP1

Issue
Number

Description

104186 Type-ahead in Activity/History/Note dialogs - type-ahead in the Contact or Schedule with fields is not working.
104188 Preferences are cut off due to stacked tabs
104398 Replace OS error with informative message when user encounters Google Mail/.net error
104555 APFW - Can't See Activities on the Weekly/Daily Calendars in Web
104869 APFW -unable to send campaign email - Templates not loading for Send Campaign dialog
104872 Google Calendar sync fails when syncing all day recurring activity
105157 Google Integration - Google acct association not recognized by Act!
105244 French APFW: unable to send campaign email - User is logged off after selecting send email campaign
105246 APFW - DE - Google Integration throws error trying to associate a database address book with Google Preferences

Version 17.1
Hotfix 2
Requires: Pro/Premium SP1

Issue
Number

Description

104869 APFW: unable to send campaign email - Templates not loading for Send Campaign dialog
104870 Update AU region Phone Regustration Support phone number for Australia s/b 39 111 0500
104872 TS - Google Calendar sync fails when syncing all day recurring activity

Version 17.1
Hotfix 1
Requires: Pro/Premium SP1

Issue
Number

Description

104398 Replace OS error with informative message when user encounters Google Mail/.net error
104542 Google Integration (Calendar and Contacts) cannot be initiated with Tools>Integrate with Google menu commands
104552 Startup view ignoring User Preference - always shows Welcome Page
104555 Web Client can’t see Activities on the Weekly/Daily Calendars in Web
104577 Web client throws script error for modal dialogs in comp mode

Version 17
Hotfix 1
Requires: Pro/Premium

Issue
Number

Description

104183 UK customers can now connect to the Marketplace.
104186 Addresses issues with the contact type-ahead feature in Activities, Notes and Histories.
104188 Backs out a UI change in the Windows Preferences pane that truncated some content.

Service Packs for Act! v16

v16.3
Service Pack 3
Requires: Pro/Premium

Issue
Number

Description

104482 Act! needs to send the serial number to AEM thru the discount code
104535 Display informative message when user navigates to Google Integration Preferences
104448 HOTFIX: Google Calendar Sync throws Obj Ref errors
104449 HOTFIX: Google Integration Broken after 2.0 API Deprecation
104450 Replace OS error with informative message when user encounters Google Mail/.net error

v16.2
Service Pack 2
Requires: Pro/Premium

Issue
Number

Description

https://help.act.com/hc/en-us/articles/360024428653
https://help.act.com/hc/en-us/articles/360024428653
https://help.act.com/hc/en-us/articles/360024423413
https://help.act.com/hc/en-us/articles/360024423413
https://help.act.com/hc/en-us/articles/360024423413
https://help.act.com/hc/en-us/articles/360024423413


104017 Syncing calendar to Google will send Google Invites

103774
Only one AEM account can be active for all Web users at a time. All Web users have access to it when any user logs on to it. All have no access
when any Web user logs off it.

103846 Act Premium Mobile - When Eastern Time Zone is selected on an iOS 7 Device activities show an hour earlier
103737 APFW: Change AEM API calls to leverage data paging feature to handle large amounts of returned data
103819 Act! prompts to rollover activities but doesn’t rollover all activities
103761 Increase AEM received data buffer from min to max allowed
103736 API calls to leverage data paging feature to handle large amounts of returned data
103804 Increase AEM received data buffer from min to max allowed
103704 Memory Leak
103423 Mail merge status window hangs and save window appears
103682 APFW: Need to pass and accept country name during call to AEM Create Account API call
103638 Contact picker no longer moves down the list after comma inserted
103426 Space in Intl English URL for EU Marketplace includes a space - making it a page not found.
103705 Timeout and error msg results from Signup for AEM
103231 Unable to communicate with the server. You may need to re-logon to Act! Premium for Web.
103681 Need to pass and accept country name during call to AEM Create Account API call

103232
Error: "The resource you are looking for has been removed, had its name changed, or is temporarily unavailable" When trying to add a field in the
APFW layout designer

v16.1
Service Pack 1
Requires: Pro/Premium

Issue
Number

Description

102921 Logged out of database when after searching company from left navbar
103047 Contacts with company names will not sync with company creation enabled
103091 All left navigation tab names and main menu tab names are not translated to french language.
103207 Logged out of database when after searching company from left navbar
103212 Logged out of database after searching groups from left navbar
103215 Remote database syncs all attachments and ignores sync set
103238 Logged out of database after searching groups from left navbar
102097 APFW Advance query on Opportunity Product
102802 Iincorrect numbers on "Act! Premium Registration and Activation Wizard"
102939 No ADT option when using 'Save As' in Word 2013
102997 New BFU for v16
103022 Editing Phone number in APFW, cursor jumps to end of field rather than staying in place
103026 No option for custom Date range in APFW
103042 “Invalid Datasource” error display when load the customer report template.
103046 No option for custom Date range in APFW
103048 Import - Dates imported from Excel or CSV change to US format or don't import
103056 Universal Search not searching on custom fields
103126 Secondary Contacts Missing from New Remote Database
103159 Clearing a recurring to-do creates a new activity for the original date of the activity after upgrading to v16
98160 Phone Formats not respecting the info on "My Record"
98914 Images display twice if mail merge to 2 or more people is viewed on IPhone
99056 Advanced Query or Group Criteria doesn't work if you use Contact and Opportunity criteria
100220 Test connection button isn't enabled until you go to another field or tab.
100890 Activities imported to Microsoft Outlook will not synchronize with Sage ACT!
101092 Date format changed during sync
101214 Error: "Item has already been added. Key in dictionary: '48' Key being added: '48'
101608 Users with the Browse role are able to import contacts via the ‘Synchronise with Outlook’ function
101690 Changing the 'Duration' does not Affect the 'End Date' of an Activity when 'Start Time' set to Timeless
101691 Copying the contents of a Time field to a Character field prefixes a date
101694 Icons lost in the menu bar after restarting ACT
102018 APFW - Target arrow not accurate on Closed Sales to Date dashboard component
102045 Highlighted contact lost when Contact List sorted
102047 Unable to use an ampersand in Email signature via the Web preferences
102071 Unable to add Location column to Activity List Dashboard
102104 Raising Follow-up Activity in APFW, saves the details with HTML tags when viewed in the ACT software
102138 Notes/history report not pulling through deleted contacts histories
102181 Activity Series as trigger does not force a "save"
102182 Schedule activity series from opportunity not scheduling with correct contact
102191 Search never completes when searching on a % sign
102194 Chrome - "No Records Found" dialog box does not function
102836 Cannot select item on history list after doing a keyword search
102882 Custom annual event fields used in Advanced Lookup cause other criteria to be ignored.
102908 Poor error description when trying to setup email integration in a remote database
102909 When calculated field added to Opportunity layout, creating new Opp from a contact displays the 1st opportunity in the list
102919 Calculated fields do not work for new contacts of company/contact field is blank
102922 APFW - Company Ellipsis on contact card, for new contacts linking to existing companies, does not respond
102924 APFW - Deleting field from database, before removing from layout, causes white screen in layout designer
102937 No Grid Lines in Opportunity Tab on Company Record
102965 "More options" feature in side bar of list view does not display search options when accessing through web browser
102978 Email Mail merge does nothing if you used the same template in succession(web)
102992 Dashboard doesn't retain last viewed
102994 Can't amend 'user' field after editing equivalent 'opportunity' field
103013 IE - Create new user from contact loses focus when typing on contact name
103107 German Untranslated strings occurs on "Act! Premium Registration and Activation Wizard (1 of 6)" dialog.
103109 Sort order in APFW Opportunities
103120 Quote template via APFW displays in $
99201 Linking contact to company locates the correct company but does not give it focus
100743 Printing envelopes using the 'DL' template prints one additional blank page
101033 Unable to change background colour on some tabs in layout designer
101259 Web info tab displays twitter mobile site
101469 Next button displays ‘Import’ after going backwards in the Import Wizard
101789 ActDiag does not Cancel when asking for verification to proceed
102192 Chrome - Persistent data from prior contact in preview pane
102193 Chrome - Timezone dialog does not render correctly

Hotfixes for Act! v16

Version 16.3
Hotfix 1
Requires: Pro/Premium SP3

Issue
Number

Description

D-04309 Documents tab causes Act! v16 to close when .net 4.6 is installed

Version 16.1
Hotfix 2
Requires: Pro/Premium SP1

Issue
Number

Description

103638 Contact picker no longer moves down the list after comma inserted
103681 Need to pass and accept country name during call to AEM Create Account API call
103682 Need to pass and accept country name during call to AEM Create Account API call (APFW)
103705 Timeout and error msg results from Signup for AEM (APFW)
103706 Timeout and error msg results from Signup for AEM

Version 16.1
Hotfix 1
Requires: Pro/Premium SP1

Issue
Number

Description

103423 Mail merge status windows appear to hang and do nothing
103426 Incorrect Marketplace URL in UK localization

Version 16
Hotfix 5
Requires: Pro/Premium

Issue
Number

Description

103046 No option for custom Date range in Web client
103207 Logged out of database when after searching company from left navbar
103238 Logged out of database after searching groups from left navbar

Version 16
Hotfix 4
Requires: Pro/Premium

Issue
Number

Description

102879 DE: Incorrect Phone Numbers and URLs in Product Licensing
102950 FR: Incorrect Phone Numbers and URLs in Product Licensing
102979 DE/FR: Uninstall of Act! v16 German leaves program directory intact
102983 FR: Publisher information incorrect on French Act! v16 release
102976 DE: Publisher information incorrect on German Act! v16 installation

Version 16
Hotfix 2
Requires: Pro/Premium

Issue
Number

Description

102840 Error occurred after logon in synchronization manager: The path is not of a legal form.
102815 Installing the ACT! Link Driver for Sage Account causes errors opening Act! v16
102813 Unable to install Act! Connect PC Client with Act! v16
102773 Replace desktop .ICO

Version 16
Hotfix 1
Requires: Pro/Premium

Issue
Number

Description

102755 Google Integration authorization issue

Service Packs for Sage ACT! 2013

Version 2013 (15.0)
Service Pack 1
Requires: Pro/Premium

Issue
Number

Description

Pro/Premium Blank screen and long load time when accessing Opportunity Detail from custom virtual directory
Pro/Premium Red X's for Process/Stage drop downs when accessing from custom virtual directory
Pro/Premium Accounting Integration - 'Update Accounting Data' function deletes Sage ACT! Company addresses
Pro/Premium Changing a Date/Time field to a Date field changes the date if the time is 00:00
Pro/Premium Email links appear red after modifying layout
Pro/Premium Error: "Object reference not set instance of an object." when deleting and email message in Microsoft Outlook® when integrated with Sage ACT!
Pro/Premium Schema update issues when updating database
Pro/Premium Outlook activity sync hangs when syncing timeless recurring activities with a 1 day+ duration
Pro/Premium Paper size set to A4 and cannot be changed when creating a new custom envelope template
Pro/Premium "Save empty copy" saves the database supplemental files in the location of the source database instead of the copy
Pro/Premium Smart Tasks not proceeding after a Sage E-marketing for ACT! step
Pro/Premium Smart Task not marked as completed if it was completed by another user
Pro/Premium Spaces in file shortcut paths replace by '%20'
Pro/Premium Static Group members removed from Group in remote databases
Pro/Premium STATUS missing from Opportunity OLEDB view
Pro/Premium Unable to create new phone fields in databases upgraded to Sage ACT! 2013 from ACT! 2007 or ACT! by Sage 2008
Pro/Premium Unable to enable Duplicate Checking after upgrading database to Sage ACT! 2013
Pro/Premium Unable to reset SA password through ACT! Diagnostics utility
Pro/Premium Unable to set alarm for a Smart Task activity step to 'No alarm'
Pro/Premium Error: "Object reference not set to instance of an object." when using Next and Previous buttons on Office 2007 integrated with Sage ACT!
Pro/Premium When clearing multiple activities, the cleared date in History shows as the current date instead of the date of the activity
Pro/Premium Performing a search in the Sage ACT! Premium mobile client causes user to be logged out of database
Premium
(Web)

Sage ACT! Premium Mobile: Dates in mobile client display in US format if database was created in Sage ACT! 2013

Premium
(Web)

Creating a Company from a Contact if a required field is not populated logs the user out of the web database

Premium
(Web)

Clearing a timeless activity defaults the activity history time to the web server's time zone

Premium
(Web)

Information entered when clearing an activity is not included when doing a Follow-up activity

Premium
(Web)

Script errors when accessing the web client in Internet Explorer when a Standard user attempts to delete an attached document for a contact that
they are not the record manager for

Hotfixes for Sage ACT! 2013

Version 2013 (15.1)
Hotfix 4
Requires: Pro/Premium SP1

Issue
Number

Description

102755 Google Integration authorization issue

Version 2013 (15.1)
Hotfix 3
Requires: Pro/Premium SP1

Issue
Number

Description

101748 Note and history creation times are not consistent with the client machine's system time
101749 Duplicating opportunity from web browser does not copy products

Version 2013 (15.1)
Hotfix 2
Requires: Pro/Premium SP1

Issue
Number

Description

101650 Blank screen and long load time when accessing Opportunity Detail from custom virtual directory
101679 Red X's for Process/Stage drop downs when accessing from custom virtual directory
101511 ACT.Server.host.exe is leaking memory

Version 2013 (15.1)
Hotfix 1
Requires: Pro/Premium SP1

Issue
Number

Description

101249 Accounting integration - changes made to Sage 50 data lost after updating linked records
101289 Export to excel with office 2003 or 2007 changes dates to US format
101347 Top portion of the left navbar is blank when startup view is Opportunity List, Task List, or any of the Calendar views

Version 2013 (15.0)
Hotfix 2
Requires: Pro/Premium

Issue
Number

Description

  Search service crashes and no results returned when indexing a large number of databases

Version 2013 (15.0)
Hotfix 1
Requires: Pro/Premium

Issue
Number

Description

  Clearing multiple Activities showed date cleared in history
  Unable to open Sage ACT! after creating new custom commands

Service Packs for Sage ACT! 2012

Version 2012 (14.1)
Service Pack 2
Requires: Premium For Web 2012 SP1

Issue
Number

Description

Premium
(Web)

Configure contact view by device

Premium
(Web)

Direct access to contact data in your Sage ACT! database (hosted on the Sage ACT! Premium web server)

Premium
(Web)

Full contact notes and histories, including attachments

Premium
(Web)

Activity viewing, scheduling, and editing

Premium
(Web)

Task list with date, type, priority, and user filters

Premium
(Web)

Calendar with daily, monthly, and list views

Premium
(Web)

Follows Sage ACT! task flows

Version 2012 (14.0)
Service Pack 1
Requires: Pro/Premium

Issue
Number

Description

Pro/Premium Users are receiving a global unique identifier (GUID) error message during Sage ACT! install.

Pro/Premium
Users are now able to perform Sage ACT! schema update (database update) with User Account Control (UAC) turned on and without having to
run as a local Windows administrator.

Pro/Premium
When a user opens Sage ACT!, the system will check to make sure the Microsoft SQL Server® (ACT7) service is running. If it is not running,
Sage ACT! will start it for the user.

Pro/Premium Picture fields were causing a view error after updating database.
Pro/Premium Timeless activities that span for more than one day miss the last day when synced to Google.

Pro/Premium
Database files synchronized from a remote database always overwriting database files in the Publisher database if both were modified, instead of
last modified file winning.

Pro/Premium Synchronizing modifications of supplemental files causes exponential sync file growth, causing remote sync to slow and timeout.
Pro/Premium File sync performance issue with attachments between the remote/subscriber database and the main/publisher database.

Pro/Premium

Sage ACT! no longer performs the file processing for access/ security on the sync from a remote/subscriber database to a main/publisher
database as is done from main/publisher to remote/subscriber database. The remote/subscriber database sends everything up to the
main/publisher database. Making this change indirectly improved sync performance on attachments from the remote/subscriber database to the
main/publisher database.

Pro/Premium Syntax error occurring when a file has had permissions changed and the file having an apostrophe in the file name.

Pro/Premium
Error displayed after changing database location on server and remote/subscriber, and manage connection information on remote/subscriber
database sync.

Pro/Premium Assigning a different drop down list to a field does not sync to remote databases.

Pro/Premium
In previous versions, updates on the parent database do not get synchronized to remote if both sides modify the same contact. Original data on
the remote replaces the changes on the parent.

Pro/Premium
The changes made in the document attached to a contact in the remote database are not synchronized to the document in the main database.
After editing and syncing to parent, a GUID number is added to the file and updated properly in the remote database. In the main database, the
document is still linked to the original file name. On remote, the document is linked to the edited attachment.

Pro/Premium Outlook contacts are removed from the remote database after syncing to main database.
Pro/Premium Unable to change settings when creating multiple remote databases.

Pro/Premium

Contact and Calendar sync were failing with the following combination of conditions: User Account Control enabled in Windows, Outlook sync is
run from the Sage ACT! menu or sync is run from the Sage Integration menu, and both Outlook and Sage Integration are run by a Windows non-
administrative user. In a failure occurs under other user permission scenarios, the proper messaging guiding users on how to resolve the issue is
displayed.

Pro/Premium Outlook add-in for Sage ACT! displays a runtime error during loading when upgrading from Sage ACT! 2011 SP1.
Pro/Premium Performance degradation when loading task list after sending an email via Outlook. Specific to Windows 7® and Office 2007 environments.

Pro/Premium
In Terminal Services environment, Act.Outlook.Sync.exe errors display when logging in with multiple users. Multiple users can now log on to the
same machine and sync Sage ACT! and Outlook simultaneously.

Pro/Premium When attempting to send an email to two separate distribution lists in the same email message, the email will not attach to contact history.

Pro/Premium
When creating a new Company record, unable to proceed without saving the Company name.Salutation field is deleted when users have set a
preference to not auto-fill the Salutation field.

Pro/Premium Error while editing data in Company list view while in customize columns mode.

Pro/Premium
In the Company detail view, if a user creates a company with Divisions and then expands the tree view in the left navigation to show divisions,
then switches the layout of the detail view to another layout, the expansion in the left navigation collapses.

Pro/Premium Company name is right-justified in the company name field after performing a lookup.
Pro/Premium If a contact with multiple name parts is not mapped in the multiple contact name dialog, nothing is imported into the database.
Pro/Premium Contacts linked to Opportunities are not exported when exporting from one database to another database.
Pro/Premium Import from Microsoft Excel® showing incorrect date format.

Pro/Premium
When admin preference to attach emails to history when sent by database users is unchecked, emails sent to other users are incorrectly to the
attachment supplemental files folder.

Pro/Premium No response after clicking "Go to Advanced Query" link in the Lookup Opportunities view.
Pro/Premium Record Manager field listed incorrectly listed as "Manager" when doing lookups.
Pro/Premium Unable to delete users in empty copy of database after applying Sage ACT! 2011 SP1 has now been resolved.
Pro/Premium Unable to change default duplicate checking criteria in empty copy of database after applying Sage ACT! 2011 SP1.
Pro/Premium Teams created in original database are not listed in empty copy of database when setting team level access.
Pro/Premium Sales Analysis by Record Manager report generating incorrect numbers with decimal point.
Pro/Premium Gross Margin by Product report calculates Total Cost incorrectly.
Pro/Premium Opportunity by Product report display incorrect information.
Pro/Premium Group reports coming up blank when all sub-groups are selected in report filters.

Pro/Premium
Deleting or changing an attachment to a Smart Task step after that Smart Task has been set to auto-run results in no attachments being included
in the Smart Task step.

Pro/Premium When adding a Resource to an Activity, the activity is duplicated in the task list if the filter criteria for the Task List is set to "All Users".
Pro/Premium Restoring database from a backup does not restore custom layouts.
Pro/Premium Attaching emails to contact history is not working in Sage ACT! Email client.
Pro/Premium History recording to Groups or Companies not working with emails sent through Sage ACT! Email client.
Pro/Premium Error message displays when users select "Add Permissions" link in Manage Users dialog screen.
Pro/Premium Sage ACT! Office Add-in disables Quick Print function in Microsoft Word 2007 & 2010 after applying Sage ACT! 2011 SP1 update.
Pro/Premium Company Web Info tab links are not refreshed with current company data if the Web Site field has never contained data.
Pro/Premium Information on relationship between two contacts is not saved when using the Relationship hyperlink.
Pro/Premium When printing calendars using Quick Print, data from days other than those showing on the screen are printing.

Pro/Premium
When using the Facebook® and Google® links in Internet Explorer® 8, information will not display in the Web Info tab due to changes made by
these websites to not display in frames.

Pro/Premium In the OLEDB2 provider, ambiguous Column Name displays when querying a table that has spill-over tables.

Pro/Premium
SDK: CustomSub Entity Record Creation Error. When attempting to create a new row for a custom sub entity, if this entity contains a yes/no or
memo field with IsTracked (generate history) set to true, then an error will be thrown either when the record is created, or when you attempt to
modify the row.

Pro/Premium
SDK: GetHistory(Guid entityID) returns empty collection. When attempting to retrieve a HistoryList using HistoryManager.GetHistory(Guid
entityID) you will be returned an empty collection regardless of the entity ID used (Activity, Contact, Company).

Pro/Premium Snoozing activity alarms causes the error: "Index was outside the bounds of the array".
Pro/Premium Follow-up activities are not marked "private" even though the preference of "Make new activities public" is unchecked.

Pro/Premium
If a user edits a layout within the first two minutes of opening Sage ACT!, Sage ACT! will switch between views and the layout designer 5 times.
This behavior is intentional; therefore there are no plans to disable the background loading at this time.

Pro/Premium When performing a mail merge to a Microsoft® Word document using Microsoft Word 2010, no history record is created for the merge.
Premium
(Web)

The Syncconfigfile.xml is not copied during install, resulting in not being able to set up the Internet Sync service.

Premium
(Web)

Contact Detail view is blank after selecting contacts from the contact lookup list, and when users navigate to other views, they are logged out of
the database.

Premium
(Web)

Clicking on an email address in the contact list gives a 404 error.

Premium
(Web)

When customizing columns in the Contact List view, the dialog box is in a distorted view that displays only the Available Fields.

Premium
(Web)

Unable to sort activities by date or time from the Web client when the activity start time is after 5:00 pm.

Premium
(Web)

Outlook displays referencing missing .dll files when loading Outlook integration.

Premium
(Web)

The Sage ACT! address book is not listed as an available address book in Outlook when configuring Outlook integration.

Premium
(Web)

When updating the time on an ACT! activity and checking the "send invitation email" box in the activity dialog box, the sender will get an updated
iCalendar invitation, but the time still shows the original time for the activity.

Premium
(Web)

Act.Outlook.Sync.exe errors when logging in with multiple users in Terminal Services.

Premium
(Web)

Unable to change record creation options in web client preferences.

Premium
(Web)

Custom date ranges in Opportunity List filters do not return any results or data.

Premium
(Web)

Sorting on the results in the Contact column after performing a Keyword search does not sort in any logical order.

Premium
(Web)

Lookup Keyword Search does not find all records, specifically if searching the Current Lookup.

Premium
(Web)

When Microsoft Word is set as the default word processor for Sage ACT! Premium (access via web), and if a user opens the mail merge fields
dialog box to add fields to the mail merge template, the fields are not listed in alphabetical order.

Premium
(Web)

Printing a mail merge generated in Microsoft Word does not record the merge in contact history.

Premium
(Web)

Unable to perform Advanced Query when accessing the web database via the Firefox browser.

Premium
(Web)

User logs in and at varying time intervals from 5 to 20 minutes, the user will start getting a "Continue to stay logged in" pop-up message. The user
then receives sequential pop-ups every 1, 2, or 5 minutes asking them to click to continue.

Hot Fizes for Sage ACT! 2012

Version 2012 (14.2)
Hotfix 5
Requires: Premium For Web 2012 SP2

Issue
Number

Description

102752 Unable to authenticate newly setup Google accounts

Version 2012 (14.2)
Hotfix 4
Requires: Premium For Web 2012 SP2

Issue
Number

Description

  Performing a search in the Sage ACT! Premium Mobile client logs user out of mobile site

Version 2012 (14.2)
Hotfix 3
Requires: Premium For Web 2012 SP2

Issue
Number

Description

99290 Outlook Activity Syncs incorrect time if timezone on client is different than timezone of server

Version 2012 (14.2)
Hotfix 2
Requires: Premium For Web 2012 SP2

Issue
Number

Description

100414 Creating a 'New' E-mail in outlook is slower when ACT! For Web Integration is enabled.

Version 2012 (14.2)
Hotfix 1
Requires: Premium For Web 2012 SP2

Issue
Number

Description

99356
Universal search from either client PC they get either ‘There are no results to display’ or the universal search screen comes back with no messages at
all. If the search is done on the server it works correctly.

99327 Save dialog displays twice when user try to save mail merge template to database server.
99289 Import does not transfer activities
99288 Templates do not run correctly when created from web client.

Version 2012 (14.1)
Hotfix 7
Requires: Pro/Premium SP1

Issue
Number

Description

102752 Unable to authenticate newly setup Google accounts

Version 2012 (14.1)
Hotfix 6
Requires: Pro/Premium SP1

Issue
Number

Description

  Changes made to Sage 50 Accounts data lost after updating linked records

Version 2012 (14.1)
Hotfix 5
Requires: Pro/Premium SP1

Issue
Number

Description

100413 Creating a 'New' E-mail in outlook is slower when ACT! For Web Integration is enabled.
100526 Clearing multiple Activities shows history cleared date as today.
100613 Installing 15.0 (uninstalling v14) removes current install of Sage Act Connect!
99288 Templates do not run correctly when created from web client.

Version 2012 (14.1)
Hotfix 4
Requires: Pro/Premium SP1

Issue
Number

Description

99659 Google activity not translated into the correct time zone (Win).

99355
Universal search from either client PC they get either ‘There are no results to display’ or the universal search screen comes back with no messages at
all. If the search is done on the server it works correctly.

99326 Save dialog displays twice when user try to save mail merge template to database server.
99235 Import does not transfer activities.
98536 Unable to send email mail merge using MS Word as word processor.
99078 Templates do not run correctly when created from web client.

Version 2012 (14.1)
Hotfix 3
Requires: Pro/Premium SP1

Issue
Number

Description

  Same as 2012 (14.2) Hotfix 3

Version 2012 (14.1)
Hotfix 2
Requires: Pro/Premium SP1

Issue
Number

Description

  Same as 2012 (14.2) Hotfix 2

Version 2012 (14.1)
Hotfix 1
Requires: Pro/Premium SP1

Issue
Number

Description

  Same as 2012 (14.2) Hotfix 1

Version 2012 (14.0)
Hotfix 2
Requires: Pro/Premium

Issue
Number

Description

 
The Contact Detail view fails to load after updating a database from one of the following versions to Sage ACT! 2012 (v14.0): ACT! 2006 (v8.2), ACT!
2007 (v9.1), ACT! 2008 (v10.0, v10.1, or v10.2). This following error appears: "Failed to create view Act.UI.IContactDetailView…"

 
The following error appears during remote database synchronization: "Synchronization has failed. String or binary data would be truncated. The
statement has been terminated. Contact your administrator for assistance."

  Synchronization performance is impacted during file processing from Subscriber (remote) to Publisher (main) database.

Version 2012 (14.0)
Hotfix 1
Requires: Pro/Premium

Issue
Number

Description

  Links on the Welcome Page are incorrect for multiple locales.
  When an Account has been imported from Sage ACT! and a subsequent change is made to the address, the change is not made in Sage ACT!.

 
If a company was imported into Sage ACT! from Accounts, contacts later added to that company do not appear in the Contacts tab of the Company
record.

  Address information does not sync between Sage ACT! and Sage 50 Accounts on the first sync attempt.
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